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Introduction

Project Summary

This Open Educational Resources for the advanced level of architectural and interior design students who learn in-depth

knowledge and skills of computer-aided visualization software.

This digital textbook will be the second book of a series entitled “Tutorials of visual graphic communication programs for
interior design” (see the addons). The author will develop a total of twenty-two chapters to teach practical graphic presentation
technigues for architectural presentations. The carefully selected nine graphic communication software and technologies

based on the author's industry experiences will be valuable learning material for designers.

The contents of this book are focusing on 1) practicing architectural diagramming using Adobe Hlustrator and DepthmapX,
2) drawing hybrid digital perspectives with Wacom tablet and Corel Painter Essential or iPad and Procreate, 3) creating
organic shape in 3D and parametric furniture modeling with Autodesk Revic and SketchUp, 41 generating real-time and phoro-
realistic rendering using Lumion, and Adobe Photoshop, 51 producing walk-through animations and practicing Virtual Reality
via Lumion, and Adobe Premiere Pro for improving presentation graphic quality. Students will learn these techniques by

following step-by-step tutorials.

This book is included multiple exercises for the reader’s practice. After completing the tutorial with user practice, the readers
can apply comprehensive techniques and knowledge to their design projects.

Objectives

First, this book will be the primary textbook for ARTID 562C Advanced Studies in Interior Design: Visualization Technigues.
ARTID 569 is for interior design seniors and graduates, and it is an optional class. Students who want to improve their
visual communication techniques seek advanced software knowledge before graduating from the program. Frequently, in this
type of tech class, students rely on the instructor's demonstrations during lectures for acquiring knowledge. Our students
build their turorials from various resources such as textbooks from the library or YouTube videos that the instructor informs.
Howsever, students have struggled because sometimes students lost the steps because of the multiple steps required to follow.
Moreover, textbooks are expensive, and typically, a coursebook deals with only an application. Besides, YouTube videos
include unnecessary information like commercial advertisements. These separated educational resources of information often
cause students confusion and frustration. Thus, this book provides unified tutorials and accessible textbooks to cover the
selected advanced-level applications.

Second, this textbook is intended for learning nine applications that promote students’ visualization techniques and
knowledge. Many other books that teach software skills cover an application for readers, and the information is for a broad
target reader. However, this book's readers will easily and comfortably find the relevant information in this digital book. The
nine applications were carefully selected based on the author's practical experiences and discussion with faculty members
in the department. The nine applications are Adobe Photoshop: an industry-standard raster graphic editor for rendering
retouch, Adobe lllustrator: a vector graphic editor for diagramming; Adobe Premiere Pro: a timeline-based video editor for
walk-through video, DepthmapX: visual and spatial network analysis software, Corel Painter Essential: a raster-based digital
art application, Autodesk Revit: a building information modeling software, Sketchup: a 3D modeling computer program, and
Lumion: 3D rendering and visualization application.

Lastly, this book supports various learning experiences. The first is to complete a famous architecture by following the tutorial.
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The second purpose is to provide exercises based on tutorials that practice for student's design projects. The open-access book
consists of twenty-three chapters, including text-based step-by-step tutorials and screen-captured images with directions. The
author will use lowa Stare University Digital Press. This free digital resource is for instructors who teach visualization classes,
and the resource can be a supplement resource for design studio instructors. Additionally, design students will follow the

instructors demonstrations in the lectures, and the students can practice the techniques after the lectures.
. P q

Students learning outcomes

The tutorials in the book can have positive impacts on students’ learning by 1) providing unified digital lecture contens to
learn the advanced level graphic communication applications for interior design and architecture students, 2) offering free and
readily available materials with texts and images, 3) supporting various examples and demonstrations that easily apply for their
current and future projects.

Affordability of the teaching contents

The book will help students’ finance because they are free with Creative Common. Whenever students need application
information, the wtorials will be available without paying for the textbook (840 to §70). The course aims to learn nine
applications. Typically, a textbook for only one application and contains lots of detailed informarion. Not all readers need
all the information for their projects. However, the book delivers essential and necessary information based on the author's

various experiences in different interior design and architecture firms from local, national, and international,

Pedagogical strategies

The book's primary pedagogical strategy is to ease students’ software learning in lectures and apply the information to their
future design projects. Some students struggle with learning technical knowledge because of the amount of information
that students must follow the instructor's demonstration. The detailed step-by-step texts and screen-captured image-based
tutorials can help students who missed steps in lectures. Some students learn lecture contents reasonably well in class, but
students cannot apply the information to their design projects. Thus, the examples and students’ self-learning exercises will

help them how to apply the techniques to their design projects,

Image credit information.

This Open Educational Resource contains multiple images from external resources. The author tried to gacher image license informarion
and authorship. If removal of images from this resource is needed, please contact the author, vongveonaiastare edu, Thank vou.
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PART ONE. IMAGE SEARCH]/
DIAGRAMMING/ DATA VISUALIZATION

Chapter 1. Image searching techniques & Diagramming

» Understand the importance of visual communication and various current skills and techniques
« Be introduced to various image searching tips

+ Understand public domain media and Creative Commons media

»  Understand what a diagram is, and the types of diagrammatic representations

Chapter 2. Illustrator — Basic

« Beintroduced to illustrator and similar applications in the industry
+ Use basic tools and commends for an illustrated work

Chapter 3. lllustrator - Diagram

» Understand a working process to create a spatial, sequential process diagram

Chapter 4. Depthmap - Data visualization

+ Understand the concepts of Space Syntax and the examples
» Ready for Space Syntax images
« Generate isovist, connectivity, and gate count graphics

Part One. Image Search/ DHagramming' Data Visualization | 3



Chapter 1. Image searching techniques &
Diagramming

Session ':1!1.|L'L'[j'l s

Upon completing this session, students will be able to:

» |CO 1) Understand the importance of visual communication and various current skills and techniques
+ (CO 2) Be introduced to various image searching tips
« |CO 3) Understand public domain media and Creative Commons media

» |CO 4} Understand what a diagram is, and the types of diagrammatic representations

E Lecture Contents

(CO1) Understand the importance of visual communication and various
current skills and techniques

Visual communication in interiors

Read this article about visual communication in interiors.

Why visual communication is important

Read this article about why visual communication is important,

Types of technology in the Architecture, Engineering, and Construction (AEC) industry

= BIM
+ Renderings

«  Animations
« VR&AR

« Computational design

4 | Image sesrching technigues



« Rapid prototyping
« Visual storytelling

« Environmental Energy analysis

Table L Overall use of Technalogical Apalications Table 2. Use of Technological Applications by Market Sactor Image credic Amy Huber &
{(Reported by Percentage of Respandents) {Reported in Percentage of Respandents) Lisa Waxrmnan
"
— -
g - [ : B oF X
N e e

[

B

&

Visual communication tools in the AEC industry

Software and apps for architecture firms: 140+ Software tools architecture firms need in [3020-Modified by Cho [Excel
download] (source: architecturequote website)

Tools of the Trade. o resource page by Bekerman Ronen, gathers information about architectural visualization.

»  Adobe Photoshop - Sketch, photo edit, rendering retouch
«  Adobe Hlustrator - illustrace, diagrams

+ Adobe Indesign - presentation, publication

«  Adobe Premiere - animation - create/edit video and audio
«  Adobe After effects - animation - create motion graphics, key-frame based animation
«  Adobe Acrobat DC - communication, presentation

»  Affinity Photo - sketch, photo edit, rendering retouch

«  Affinity Designer - illustrate, diagrams

«  Affinity Publisher - presentation, publication

» Corel Corel DRAW - drafting, illustrate

« Corel Painter - digital art

«  AutoCAD + architecture - drafting

» AutaCAD LT - drafting

«  Revit— BIM, drafting, 3d modeling

« 3DS MAX - 3d modeling

+ Sketchbook - Sketch

«  BIM 360 - collaborating work

« Dynamo studio - parametric design

» Bluebeam - Drawing review, comments, communications
« FRhino - 3d modeling

+  Grasshopper - parametric design

»  Sketchup pro - 3d modeling

« Solidworks - 3d modeling
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+ Vectorworks - BIM, 2d drafting, 3d modeling
+ Cinema 4D - 3d modeling

« Blender - 3d modeling

« VRAY - post-rendering

« Enscape - post-rendering, VR

«  Lumion 3D - post-rendering, VR

« Corona - post-rendering

(CO2) Be introduced to various image searching tips

General search engines for high-quality images Design Portfolio websites
*  Goorle imaze search - Tool s  Behance

« Bing imag ch - Fi «  Dribbble

*  Pinterest +  Issuug

=  Yandex - Filiers

*  Yahoo - advanced

Archirectural and interior design magazines

. . (commercial)
Reverse image search engines
. s Archdaily
: 'Fl'lnE'ne Visual b ool s Betnil design blog
: G:;; eln?ﬁ: isual search too o O
+ Frame
s Wallpaper
+  Dasign milk
y T e * o
Stock image search engines B
s  Healtheare design
« Shutter stock + Dffice snapshots
«  Gatty images s  Education snapshots
= . e -
= Adobe stock
= 1I3RF

(CO3) Understand public domain media and Creative Commons media

Public domain media

Copyright.gov explains the public domain as follows: “A work of authorship is in the “public domain™ if it is no longer under
capyright protection or if it failed to meet the requirements for copyright permission of the former copyright owner.” Finding

something on the internet does not mean it is in the public domain (Blechner, 2021, July 21},
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Creative commons media

Creative Commaons is a non-profit that helps share + reuse creativity & knowledge via free legal and technological tools. These
tools are not alternatives to copyright laws, rather they work alongside them (About the licenses, 2017, November 7).

Rovalty-free media

Royalty-free images aren't necessarily free. [n most cases, you'll have to pay a one-time fee to obtain the rights to use the image.
Then you can use it as many times as you like. The “free” in “rovalty-free” only means that you do not have to pay rovalties 1o

the owner of the image every time you use it. For a comprehensive read on royalty-free images, check out this guide by Amos

Struck (Struck, 2020, April 300,

+« Wikimedia Commons

+ Flicker
= Pizabay
+ Unsplash

+ Public Domain Pictures.net

+« Burst
+ Old book illustrations
+ The New York Public Librarv Digital Collections

You can find more search engines including images, oudio, and video on this link.

(CO4) Understand what a diagram is, and the types of diagrammatic
representations

What is a diagram?

“A diagram is a symbolic representation of information using visualization techniques” - Ouford languages
“A simplified drawing showing the appearance, structure, ar working of something; a schematic representation” - Wikipedia

“An architecture diagram is a graphical representation of a set of concepts, that is part of the architecture, including their

principles, elements, and components” - Dragon 1

A diagram is the spatialization of a selective abstraction and/or reduction of a concept or phenomenon. In other words, a
diagram is the architecture of an idea or entity. A diagram can be described as an imaginative process that by virtue of analog

and digital construction procedures helps in the transformation of typologies, configurations, and madels.
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Types of diagrammatic representations

Programmatic representation

Distribution of the program

This dl'ugrnm is an nnmp!u:

Considerable issues : '\ of a programmatic diagram.
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"B - ¢ Each dashed rounded
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Contextual representation

Implementationfvisual

Site conditions

' DELARAM, NIMRUZ, AFGHANIST AR

T T e e T T

el

AR AT

Spatial representation

Design concept

This & diagram can be an
example of an
irnTﬂnrn{urﬁun-’vi_muI
diagram that represenes the
contextual issue in the site.
The left top diagram shows
the site’s relationship with
other relaged buildings and
traffics, The middle image
of the top diagram shows
the best circulation with the
]Jr.r.l']'&ings on the site. The
right top diagram presents
how to connect

buildings with the
cenditions, The left bottom
i shows the
p:ﬂﬁr‘?nr:m flow and the
middle bottom diagram rell
the outside garden for the
public. The last diagram
shows the .Eluﬂr:[fngis twisted
for the dynamic views and
hounces back to the existing
building.

This dingram shows the
warious site condition at
once. It presents the
location of the site and the
surraundings [ike the major
and secondary road,
topagraphy, river, potential
ﬁnmf ared, green spaces,
LW, ITLEJ OF View [0 Cover,
the short history of the site,
elevation, ethnicity,
language, and other
infrastructre informarion.
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These sequential four
diagrams show the design
cencept of thix building
The green-colored fine
shows the nature from the
surreundings and the narwre
in the building will connect.

1. Floor area ratio - 30% 2 Maximum volume 3. Extension of the forest 4. Space program

Spatial relationships

This diagram and the
diagram above are from the
same project. This floor
plﬂn with green color rfcm']}r
shows the concept of
connecting naire in the
space. Additionally, the
gray-colored space is for the
public [ohby extended from
the inside out,

Volumetric relationships
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This panel presenes twao
diagrams together with an
exterior perspective
rendering. The left tap four
sequentiol dingrams show
the volumetric relationship
of the three masses with the
original structure that must
be remained. The right side
diagrams show the two fToor
plans isomeiric views, This
will help reviewers to bereer
urderstand the
relationships of the spaces.

-
P,

B S mems ot m

Construction representation

Structure and materials

This panel image shows twa
images together, one is an
infcrior perspective
rendering to show the mood
of the space, and the other
ix an exploded diagrom that
explains the structure and
muterials of “the !‘lr.ufdrng
with annotation technigues,
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Swstem operation

Cudlabryrabes wwwng oo

Solution and Strategy
in interior design

# -

HFn i o p—— Sl Py gty o ey by

Ay w—— # A e b v g —
T T S S S g =

s we——— e
bt e b B e g

b e

R e
ey ek il
b e b by ey S — e P —

Fl -t IP‘I#I

This group of diagrams
shows the svstems of the
space. Generally,
architecture and interior
spaces contain many
systems together, like
HVAC systems, signage
systerrs, furniturne systens,
AV systems, lighting
systems, circulation SVSEES,
and more. This diagram
represents the interior
systems together with leader
fines and short descriptions,
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Chapter 2. Illustrator - Basic

Session Objectives

Upon completing this session, students will be able to:

» (CO 1} Be introduced to illustrator and similar applications in the industry,
» |CO 2) Use basic tools and commends for an illustrated work.

E.’ Lecture Contents

(CO1) Be introduced to illustrator and similar applications in the industry

Abour Adobe Illustrator

Adobe Illustrator is the industry-standard vector graphics app that lets you create logos, icons, drawings, typography, and
complex illustrations for any medium. Adabe Hllustrator is the industry-standard design app that lets you capture your creative
vision with shapes, color, effects, and typography.

Adobe illustrator work examples, please warch the video linked in the texts below to understand the process of the illustrated
drawings.

1. Perspective drawing {Digital Art Creation, 2017}
2, Isometric drawing (Satori Graphics, 2019

Alternatives of Adobe Hlustrator,

Affinity Designer
Corel Draw
Inkscape

e L3 o =

Gravit designer
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(CO2) Use basic tools and commends for an illustrated work

Note. The information below is from the Adobe illustrator user guide and selecred rools, commands, and panels by the instructor.

Adobe illustrator interface

—

Adobe
Open Adobe Hlustratar 2020 by clicking the icon: Ik

You may be required to sign in to confirm your license.

Once the application opens, you will see this start page. On the start page, you can create a new file using a template, browse
to open a file, or open a recent file.

Once you click the |Create New]| button, a new windaw will pop up.

+ [STEP 01| Enter a file name to save. e.g. [First name_Last name_Exercizse 1 Diagram|.
« |STEP 02| Change the unit to [Inches].
= |STEP 03] Update the size of the artboard size [Width=20in, Height=14in] for the Exercise 1.

Note 1. Bleed sizes for printing documents. Often designers create a document a bir bigger (0.1257) than an artboard size for whire space.

However, documents for web or computer use do not need to have the bleed becawse there (s no space to cut.
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Note 2. Color Modes. [CMYK| = Printing color, [RGBJ = Web color.
Note 3. Raster Effect. Height (300 ppil = Printing (more memory usel, Screen (72 ppi) = Web (less memory usel.

« [STEP 04) Click [Creare].

Mew Docursent

(T) Rocent

EX1_Diagram_01_Yongyeon Cho

Let's start something new.

Start with your own document settings, pre-fomatted

imploe Soame of our halpho arud starter files

CRE Color

fa "y
Crenin || Close )

Save the file by pressing [ctrl+s| on the kevboard, before you start your work.

Once you create a n will see a white artboard with the workspace |Essentials),

ew file, you
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The workspace is modifiable, meaning vou can change what you want. Adobe Illustrator offers some recommended

workspaces for users. Once you click the workspace switcher, you can choose one of the settings. | recommend using the
[PAINTING] preset.

Autamation
Ezsentials

Ezsentials Clazsic

Layout

L

Printing and Proofing

Tracing

Typography
Web
Reset Essentials
MNew Warkspace...
Manage Workspaces...

The image below is the |Painting| workspace and illustrates the name of the interface.

Notel. Once you press the [tab] key on the kevboard, vou can hide all panels.

Note2. For a presentation mode, press [Shift=F| or click the presentation mode on the bottom of the tool panel.
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Presentation Mode shiftF

» Normal Screen Mode
Full Screen Mode with Menu Bar
Full Screen Mode

Note3, Also, you can minimize and maximize the panel groups by clicking the arrow on the top-right corner of the panel groups

Document setup

On the document set, you can change the units, bleed size, and Arthoards size.

To edit Arthoards size:

« |STEP 01| Click [Document Setup| on the control panel.

| EHEIERE R —— o Rl - < oo [ v [l | ovament sty | e
« |STEP 02] Click [Edit Artboards].
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Units: Inches

= My e
Bleed: . Oin

[_] Show Images In Outline Mode
(] Highlight Substituted Glyphs

Transparency and Overprint

Grid Sipe HE‘dIIJm

Giid Colors: [l Light
|| Simulate Colored Paper
Preset: [Medium Resolution] Custom...

B Discard White Overprint in Output

= [STEP 03] To apen the arthoard, you can also click |Artboard tool| - or press [shift+o] on the keyboard.
« [STEP 04] You can change the current Artboard size by editing [W] and [H] of the document or vou can drag the blue box

on the arthoard.

« [STEP 03] If vou need it, you can also add new artboards. Once you print or make a PDF file, it will show on different
pages.
Preferences

On Preferences, vou can change many things when you operate the application. [ usuvally use the preferences to change the

units and wser interface.

Clogunesd Selagp o
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Tool panel & Control panel (Basic)

Selection tool ' - [v]

The selection tool is to select an object/objects.

« |STEP01] To select an o drag over an object/ objects/ a group/ groups.

bject, click or

7= - pr—— —

Fangpres Ul e | g W 1RE S @ AL P LU Brevi] =

+ |STEP 02] To select an object inside of a group, you must double click to open the group and then select an object/objects
by clicking or dragging it over.
« [STEP 03] To select multiple objects, hold the |shift] key and select another objects).

For more information abaut the selection tool, please read the Selecting Objects help page on the Adobe website.

Direct selection tool u - [a]

This direct selection tool is to select an anchor point/anchor points in an object/objectsfa group/groaps.

« |STEP 01] You can select anchor pointis) by clicking or dragging over it.
« |STEF 02] To select multiple anchor points, hold the [shift] key and select another anchor pointis).
« [STEFP 03] To move the selected anchor pointis), you should drag and drop the anchor(s) or use keyboard direction keys.
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« |STEP (4] You can convert the anchors’ edge style by clicking convert icons _ on the control

panel.
f

Fungpres Chn b | g W 1550 @ L1

+ |STEP 05] The curve shapes can be editable by contralling handles.
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Fangpres Chu fams | Mageas . 18057 & L1 J0% CMYLSPU Fiessi ®

« |STEP 0&] You can remove anchors by clicking [remove selected anchor point icon|
A * e v K m
o=y

g LS 3 LS EMTRIERU Frarid §

Pen tool ﬂ - [p]

The Pen toal is THE MOST IMPORTANT tool in this application.
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This iz a drawing tool that creates an object by mouze left click.

The Pen tool supports both straight lines (click) and curved lines (drag),

&

An object can be closed and open. This can be identified with this identifier ™.

If vou need to draw a 45-degree line or a 90-degree line, hold the [Shift] kev.

g

mun Clm Fratees | Magrne WILD o @ &) FPS [TRIPE/ENY Ry &

If yvou want to add an anchor point, mouse over on edge of an object, the mouse icon changes to +, then you can click to add an

anchor point.

For more information about the Pen tool, please read the Drowing Pen Curvature or Pencil help page.

'
Paintbrush tool B - [b]

The Paintbrush tool is a free-form drawing tool.
Typically, designers/illustrators use this tool with 2 Wacom Tablet (pressure-sensitive).

For more information abaut the paintbrush tool, please read the Create and Edit Artwork with Painthrush help page.

.

Type ool

The Type tool is used to add text to a design.
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« T
~¢" Type on a Path Tool
\'T" Vertical Type Tool

T
’S

There are 7 ways to add text:

= Option 1. Add horizontal text by clicking on the artboard.
« Option 2. Add horizontal text block by drag and drop.

« Option 3. Add horizontal text to an object by clicking the object.

= Option 4. Add text on an edge of an object or a path by selecting [Tvpe on a Path tool],
« Option 5. Add vertical text by clicking on the artboard.

+ Option 6. Add vertical text block by drag and drop.

Option 7. Add vertical text to an object by clicking the object.

- - - oy

Famgpres Db e | g W1LE " 8 &1 J0S MY RSP Frertem] ]

For more information regarding the type tool, please read the Creating Text help page.

Shapes

There are 5 different basic shapes in this application.

« Recrangle tool - [m|
« Ellipse tool

» Polygon tool

+  Star tool
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+ Line segment tool

There are two ways to create a shape. One is clicking to open the shape window to enter numbers, the other is dragging to

manually draw a shape.

Ellipse

Width:

Height: 1 in

it

For more information regarding the shapes tool, please read the Draw Basic Shapes help page.

Eyvedropper tool H

The evedropper tool is to copy the attributes of an object by clicking the object.

To apply the artributes, hold the [Alt] key and click an object.
) ] - . (LI [ =

- (5 [ . — R s b
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For more information about the eyedropper tool, please read the Appearance Anributes help page,
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& more [Edit toolbars...] -

Once you click this |Edit toolbars..], more toolbars can use.

Free Transform is a different transform tool than just using a section twol,
Oince you click an object, select [Free Transform Tool|.

There are three options

+ Free Transform
» Perspective distort
+ Free distort
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For more information about the free transform tool, please read the Scaling Shearing and Distorting Objects help page.

Fill & Stroke

Change to the Default setting (Fill-White, Stroke-Black) - |d].

To change the Fill color & gradient, use the control panel.

To change Stroke color & types, click |Stroke| on the control panel.
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Panel Groups

Swatches

A swatches panel is a way to save the color that you use in a drawing.

The image below shows the default swatch board.

You can add new color from the library by clicking the stacked lines icon .
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Color Guide

The Color Guide panel is another tool to select a color. This panel propeses color harmomny.
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Color Guide

LINET

Shades Tints

To apply the color, you can just click the color that you want to apply.

For more information about the Color Guide, please read the Color Group Harmonies help page.

Gradient

Oince you click the gradient on the gradient panel, the gradient will apply to the fill or the stroke.

Locabon:

To change the gradient type, color, opacity, location, and degree.

And also, vou can control the direction by using the gradient tool from the toolbar.
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Transparency

The transparency tool is to adjust the object or group transparency and blending modes.

Click the Transparency tab on the panels.

[ | Isolate Blending | | Knockout Group
[ | Opacity & Mask Define Knockout Shape
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To edit the opacity or blending modes, click the arrow and change the values or the mode.
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For more information about Transparency, please read the Transparency blending modes help page.

Character

The character panel is for editing texts in vour illustrator file.
To open the full panel, you will need to double-click the tab.

From the character panel, you can edit font, font style, font size, leading, and maore.

32 | Chapter 2. Hlustrator - Basic



imagye credir Screen

ﬁrpl!ure.f and mm!i_ﬁrﬂ' by

Charseter A the Auther from Adobe
illustraror,
111 Touch Type Tool
« Myriad Pro B
Reguilas C
I D
] E
K F
L G
English: LISA ' H

Charocler panif

A. Fanel menu B. Font C. Font Style D, Leading E. Tracking F. Horizontal Scale G. Character Rotation H. Anti-Aliasing
Method L Font Size 1. Keming K. Vertical Scale L. Baseline Shift

If you need 1o change your font to all capital letters, open the character panel menu and select All Caps.

Lorem ipsum

LOREM IPSUM DOLOR SIT AMET, CONSEC
TETUER ADIPISCING ELIT, SED DIAM

NONUMMY MNIBH EUISMOD TINCIDUNT UT
LAOREET DOLORE MAGNA ALIQUAM ERAT

| orem insum

You may also need to break the fonts/texts for additional edits. You choose the types and mouse right-click, and select [Create

Outlines).

-
i

Lorem ipsum el

LOREM IPSUM DOLORSITA oo
TETUER ADIPISCING ELIT, SI =
NONUMMY MIEH ELISMOD -:__,
LAOREET DOLORE MAGNA ArCtgusm crisl

Chapter 2 Hlustrator - Basic | 23



Lorem ipsum

LOREM IPSUM DOLOR SIT AMET, CONSEC-
TETUER ADIPISCING ELIT, SED DIAM

NONUMMY NIBH EUISMOD TINCIDUNT UT
LAOREET DOLORE MAGNA ALIQUAM ERAT

For more information about formatting type, please read the Formatting tvpe help page.

Paragraph

The paragraph panel is for editing paragraph alignment and indents and hyphenation.

y image credit: Screen

p captured and modified by
- x the Auther from Adobe
R - Hllustraror.

E & 4 B8 & B

E— K S it B 2om —F

—"E2 i
0—WE e KSop —G
[~ [«|Hyphariss

Povagraph ponef (all options shown)

A, Alignment and Justification B, Left Indent C. First Line Left indent D. Space Before Paragraph E. Hyphenation F. Right
Indent G. Space After Paragraph

For more information about formatting paragraphs, please read the Formatting Paragraphs help page.

Align

Align panel is to controls the object or group by aligning/distributing with other selected objects ar groups.
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For more information about Align tool, please read the Moving, Aligning, and Distributing Objects help page,

Pathfinder

Pathfinder panel (Shape Modes and Pathfinders) is for combining objects

Tramspasency
Pat hfincher

0

Pathfinders

o & &

For more information about Pathfinder tools, please read the Combining Objects help page.

Appearance

The appearance panel is to view and adjust the appearance attributes for an object, group, or layer.
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image credit: Screen
captured ond modified by
the Author from Adobe
llustrator,

Appearance panel bsting aitnbutes of @ grouped object

A, Path with stroke, fill, and drop shadow eflect B, Path with effect €. Add New Stroke button D. Add New Fill button E, Add
Effect button F. Clear Appearance button G, Duplicate Selecied ltem button

You can add/edit strokes and/or fill.

Appearane
e el tion
Opacty: |
Chrole= [ 4 pt Doshes Oulside
|H'|-'11'f (LS

[

Opacty: | it

To add an effect, click the Add Effect button and select an effect.
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For more information about Appearance, please read the Appearance Auributes help page.

Place [shift+ctrl+p]

Use the Place command to load other bitmap images on vour arthoard.

« [STEP 01) Click [File] =[Place] and select an image that you want to add, and click [Place].
« |STEP 02| Drag and drop to place the linked image.

A A T P P el Cramt [E e bam -

foogywan Chw Beercos | Dlagremr- WPE2 e @ 15005 UMY LHIPU Proviews &

Piured Tiwesrs
Ernbibrin_

« [STEP 03| To replace the image with another image, vou should click the nome of the image on the control panel and

click replace.
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Also, you can embed the image into the file to avoid missing links in the future.

For more information about the Place function, please read the Importing Arowork Files help page,

Image trace

Image trace command is for converting a bitmap image to a vector abject (editable in illustrator).

« |STEF 01| Before using the command, please embed the linked image,
« |STEP 02] Once you click an arrow next to the [image trace] button, you can see some preset to convert image to object.

You can try the preset that is appropriate for vour purpose.

File Edit Ohject Type Sedect Effect  View

bnae WISHOE- - Mareralies .. Faneparent (MY PRI 00 Linssplad image Tran v ‘ oo e Oty (005
Yongyeon Cho_Exercies 1 Diagram.-WISLal® @ 150K (CMYIL/GPU Praview) M
[ Decfalt |
High Fidelity Photo
Lo Frcefity Photo
1 Colors
6 Colors

16 Colors

Shades of Gray

fiack and White Logo
Sketched Art
Silbrnesttes

Lme Art

Techmical Drawnng

= |[STEP 03] If vou need any additional adjustment for the converted object other than the presets, please open the image
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To convert the editable object, please click [Expand| on the control panel.

For more information about image trace functions, please read the Image Trace help page.

Group [ctrl+g|, ungroup, and expand objects

For more information groups and expanding objects, please read the Grouping Expanding Objects help page.

Ruler [ctrl+r] and guides

For more information about rulers and guides, please read the Rulers, Guides, and Crop Marks help page.

Layers

For more information about lavers, please read the Using Lavers help page.
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Chapter 3. Illustrator - Diagram

Session Objectives

Upon completing this session, students will be able to:

» (CO 1) Understand a working process to create a spatial, sequential process diagram

¥ session Highlights

At the end of the session, students will be able to create the graphics below.

KRTIOD 5690 - F20 - YOMGYEONKHD  Jrmagr credic Modificd
diagram hased ona
diagram - Mulembo House

PROGRAMMING
: P : by Trienal de Arquitecroro
- from Pyo, M., & Kim, 5,
I w . 2012 by Che
* -+
SHAPING
— <> —

ROOF DEFORMATION

SHADE AN CROST VENTILATION GENERLITH DEFOIRGEATION: VENTILATEON ARD RATN WLTER CELETTION
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E Lecture Contents

(CO1) Understand a working process to create a spatial, sequential process
diagram

In this tutorial, vou will see a working process to create a spatial, sequential process diagram. Through the process, students

will learn how to use the tools and commend in Hlustrator.

Create a new file

« |STEP 01) Open Adobe illustrator. (in this tutorial, | used the illustrator 2021 version)
= |STEP 02] Create a new file by clicking [CREATE NEW)

« [STEF 03] Enter the file name [Firstname_Lastname_Exercise 1 Diagram),

+ |STEP 04| Enter artboard size |[20in x 14in].

= |STEP 05] Confirm Color mode [CMYE],

« [STEP 08| Raster effect |300 dpi].

Let’s start something new.

Save the new file

+ [STEP 01] by clicking [FILE| = |[SAVE] or, press [CTRL+5].

+ |STEP 02| Find/create a project folder.

. [STEP 03| Click [SAVE].

+ [STEP 04| Change the version to Hlustrator CC by clicking the version.
+ |STEP 05] Click |OK].

= |[STEP 0&| Click [OK] on the warning message.
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Place a background image

« [STEP 01] For the exercise, you must download the image file and use it.

« |STEP 02| For your project, vou can use a sketch file as a background image.
« |STEP 03| Click [FILE] > Click [PLACE] or, Press [SHIFT+CTRL+F|.

« [STEP 04] Select an image file that you use as a guide for a diagram.

+ |STEP 05] Click a place on the arthoard.
= |STEP 0&] Confirm you are using [SELECTION TOOL],
« [STEP 07] Adjust the scale by dragging and dropping the edge of the image. You may hold the |[SHIFT] key to keep the

image ratio. Or you can use [TRANSFORM PANEL| to adjust the size of the image. Or adjust the size on [CONTROL

PANEL].
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Adjust background image transparency and add new layers

= [STEP 01| Click the background image.

« [STEP 02] Adjust the value of Opacity to 30 from |[CONTROL PANEL]. Or Click [TRANSPARENCY PANEL] to open the
panel, and adjust the opacity value to 30%.

= |[STEP 03] Double click the [LAYER 1] layer from [LAYERS PANEL|to update layer name [BACKGROUNDS|.
Tip. Use a name that you can recognize beeter for the laver number.

« |STEP 04| Click the |+] icon three times from [LAYERS PANEL] to add three new layers.

= [STEP 03] Adjust names for each new layers [DIAGRAMS|, |JARROWS and ICONS), and [TEXTS].

+ [STEP 06] Lock the [BACKGROUNDS] layer.

BT o = e e e
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Draw the top-left corner diagram to start

+ |STEP 01| Press [Z] to zoom in and out. Or you can press [CTRL+ +| to zoom in, press [CTRL + -] to zoom out.

« |STEP 02| Press |[SPACE]| key to handing the artboard.

« |STEP 03] Press [P to use the [PEN| tool.

« |STEP 04| Confirm you selected the |DIAGRAMS] layer.

« |STEP 05] Start to draw the site line. If yvou want to use only lines without fill color, you must click the [FILL] and change

the color to [NONE].
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« [STEP 08 Draw the building base volume using the [PEN| tool.
Tip 1. Smart Guides [CTRL+U| is on by default. You will see the snaps while vou draw, use the snap. Hold [SHIFT| key o draw 0,
45, 90-degree lines.
Tip 2. Hustrator is a drawing tool; this is nor AweoCAD. That means they don't need to be 100 % precise. Some arristic expression is
allowable.
Suppose you want to draw with the isometric grid line. Please follow this step in the link.

« [STEP 07) Click the object and click [STROKE] from the [CONTROL PANEL] to open [STROKE PANEL| to adjust the
stroke thickness and align stroke.
Tip. You can apen the [STROKE PANEL] from [APPEARANCE PANEL] or (STROKE PANEL] directly.

+ [STEP 08] Adjust the [WEIGHT] and [ALINE STROKE],
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[STEF 09] Draw the edge of the box using the [FEN TOOL|. You may also adjust [STROKE] as well.
e % - & [} 4+ e " | ]
w - 9 EE S P h S W0 . Y LR - % -

Fuagpres Lbn brmme | Bagems o 8 DS (AR GRS Framme: &

Add angled texts

« [STEP 01) Click [TYPE TOOL] or press [T].
» |STEP 02] Draw and drop to add a text box.
Tip. When you create a rext box, be careful with the cursor icon changes. If vou want to draw a pach/object as a rext box, you need
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to click the pathjobfect. Otherwise, vou need to draw and drop in an empiy area.
« |STEP 03] In the text box, some placeholder will automatically fill. You need to delete the placeholders and add your text.
« |STEF 04| Edit the font, size, leadings, and more,
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[STEF 03] Mouse right-click on the text box.

[STEP 06] Click [CREATE OUTLINES] to break the texts.

Tip. If yon skip this [CREATE OUTLINE] process, [FREE DISTORT] will not be applied.
[STEP 07| Click [FREE TRANSFORM TOOL] and click [FREE DISTORT].

[STEP 08] Drag and drop the corner of the selected text box to create angled text.

-

-
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« |STEP 09] Adjust the text color/transparency/effect.

48 | Chapter 3. Hlustrator - Diagram



Finishing up the first diagram

= [STEP 01] Adjust the building volume fill color ta hide the site line.
« [STEP 02] Adjust the site line color to indicate the volume of the site.

Faagpems Pl bemeom 1 Mageem o™ @ 16FS LCU B SR Framme

Note. For the exercise, you can add/develop the diagram thar you are given. DESIGNERS!!

Ready to make the second diagram

|STEF 01] Select the first diagram = Mouse right-click = Select [GROUP],

[STEP 02] Hold JALT] key = Drag and drop the first diagram to the second diagram location.
[STEF 03] Select the copied second diagram > Mouse right-click » Select [UNGROUP].
|STEF 04| Remove and edit to create the second diagram.

-
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Draw lines and fill colors

« [STEF 01) Select the group = Mouse right-click = Click [ARRANGE] = Click [SEND BACKWARD| Or Select the group =

Fress [CTRL+| |.
& :
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+ |STEF 02] Select [LINE SEGMENT TOOL]
« [STEP 03] Draw lines to set the guide the color fill.
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« [STEP 04] Select the lines that you draw by using [SELECTION TOOL].
« |STEP 05] Make a group by pressing [CTRL+G| to prevent any accidental selection while using [PEN TOOL].
|STEF 6] And lock the line group by clicking the grouped line group from [LAYERS PANEL].
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[STEF 07| Select |PEN TOOL) 1o draw the color-filled area.
[STEP 08] Draw color-filled objects individually. And adjust colors.

Tip 1. If you want to make the object line precisely, use outline mode by pressing [CTRL+ Y], It will allow us to see only outlines: no

-

color fill, no smroke. To exic the ontline mode, press [CTRL+ Y| again.

Tip 2. Also use [DIRECT SELECTION TOOL], shortcut [A] to adfust the anchor points.
[STEF (9] Make groups by color of the objects.

[STEP 10| hMake a group the groups.

[STEP 11] Change the order of the group.

Tip. Please see the [LAYERS PANEL] to see the drawing orders.

-

Changing color with using Swatches and Library

« [STEP 01) Previously you used the default swatches. You can select color by double-clicking Fill color and pick a color
from [COLOR PICKER]
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« [STEP 02] In this turorial, you will add new colors from the background image using [EYEDROPPER TOOL|, shortcut [I].
« |STEP 03| Hide the [DIAGRAMS]| layer by clicking the eye icon by the layer on the [LAYER PANEL]

= |STEP 04| Unlock the [BACKGROUNDS] layer by unclicking the lock icon.

« [STEP 03] Select the image = change Opacity to 100%.

« |STEP 0&| Click [EYEDROPPER TOOL| from Tool panels, shartcue [1].

= |STEP 07) Select a color that you want to add to the swatches.

« [STEP 08) Click the + icon from the [SWATCHES PANEL] to add.

« |STEP 09] Change the name if needed, check [ADD TO MY LIBRARY).
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+ |STEP 10| Repeat this process to save colors from a reference image.
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« [STEP 11] Adjust the image opacity to 30%.

+ [STEP 12| Lock the [BACKGROUNDS] layer.

« [STEP 13| Unhide the |DIAGRAMS] laver,

+ [STEP 14] Click the Folder icon to create a swatch folder = Name it = Select the swatches that vou made = Drag and drop
off the swatches to the folder.

« [STEP 15] Select an object/ a group = make sure Fill color is activated = select a swatch to apply the color to the object/ a

group.

« |STEP 18] Make a group for the [DIAGRAM 2| and rename the group from the [LAYER PANEL]

[ (- =
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Create the third diagram

= [STEP 01| Copy the diagram 2 group to the diagram 3 location by holding [ALT] key and dragging and dropping the
object/the group. If vou want to copy to a straight line, hold the [SHIFT] key while dragging and dropping the object/the
group.

= |[STEP 02] If the background image is off from the copied diagram, you can change the image location.

+ [STEP 03] Repeat [Ready to make the second diagram| to [Changing color with using Swatches and Library] to create the
third diagram.

= |STEP 04| Consider the drawing orders, the thickness of lines, and the color of the object.

Fangpems Ubn bemvee | Bingees u @ 1E%

Create Diagram 4

« [STEFP 01] For Diagram £, vou only need wo add the Yellow square and tree in the middle of the site. You don't need to
ungroup and draw new all. You will keep the elements and only add the yellow square and three.

» |STEP 02] To see the background image, vou can change the opacity value of the copied diagram or adjust the
transparency style to [MULTIPLY).
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[STEF 03] Draw the YELLOW AREA and update the color and thickness of the stroke.
[STEP (4] Ungroup the copied diagram.
[STEF 05] Update drawing order.

[STEF 06| Group the copied diagram including the vellow area with the trees.
[STEP 07] Rename of the group.
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Align the four diagrams

= |[STEP 01| Select the four diagrams.
« [STEP 02) Open [ALIGN PANEL]| or find the align icons on the [CONTROL PANEL).
« |STEP 03] Click [VERTICAL ALIGN BOTTOM] icon.

= |[STEP 04| Click [HORIZENTAL DISTRIBUTE CENTER] icon.

= D —_— - pa i s =2 ok
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Create Diagram 5 and o

« [STEP 01) Copy from diagram 4 to Diagram 3, &, 7, and &,

« |STEP 02] Align with Diagram 1 for diagram 5 and Dagram 3 for diagram 5.
= |[STEP 03] Move the image if necessary.

« [STEP 04] Ungroup the copied diagram.

« |STEP 05] Remove ohjects that are not needed.

= |[STEP 0&] Group the object and rename it.
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Create Diagram 7 and 8

« [STEP 01) Diagram 7 will be updated from diagram 4.

« |STEP 02] Update the color and stroke.

« [STEF 03] For the dashed line, vou will need to open the [STROKE PANEL] and check the Dashed Line box and value
dash.

« |STEP (4] Add objects to the ground by using [PEN TOOLJ.
Tip. Lock the diagram while vou draw the ground line to prevent merging objects,

« [STEP 05) Adjust drawing order.
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Create Diagram © and 10

« [STEP 01) Copy diagram 9 and 10 from diagram 8.

« |STEP 02| Scale change with keeping the ratio of the group by holding the [SHIFT] key.

« [STEF 03] Update fill colors and strokes.

« [STEP 04] Add detailed elements (Sun and water tanks| with [GEOMATICS] and [PEN TOOL]

L
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Add/edit Gradients on the roofs

= [STEP 01] Click an object to that you want to add a gradient.

+ [STEP 02] Click [GRADIENT PANEL].

« |STEP 03] Make sure you selected [FILL].

« [STEP 04] Click [GRADIENT] to activate.

« [STEP 05] Click the [GRADIENT] icon on the tool panel to control gradient direction.

« |STEP D& Double-click the black color on the [GRADIENT PANEL] to select a color.

= |[STEP 07] Double-click the white color on the [GRADIENT PANEL| to select a color,

« [STEP 08] If vou want to add color to the gradient that vou made, click in the middle of the gradient and change the
color. You can also adjust the percentages of the gradient.

= [STEP 09] Update transparency style to Multiple to show the behind the objects.

E- 8 —
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Add hatch using Make Clipping Mask

« [STEP 01] Create a pattern as a group with an object/objects.
« |STEP 02] Draw a line and copy the line multiple times and align [HORIZENTAL DISTRIBUTE CENTER| and make the
lines to a group.
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« [STEP 03| Move the pattern group to where you want to apply.
« |STEP 04] Draw the boundary line {must be closed a loaf).

» |STEP 05] Select the pattern group (below) and the boundary line (above).
+ [STEP 06 Mouse righe-click > click [MAKE CLIPPING MASK].

(4] LH]
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Add arrows

= |[STEP 01] Hlustrator has lots of brushes in the library.
+ [STEP 02| Click [BRUSH PANEL = click the panel extension > Click [OPEN BRUSH LIBRAY] » Click [ARROWS] > Click
[ARROWS_STANDARD).

Famgrens U s | Dwgees o @ L5 BPS [L U0 LSS P

= |[STEP 03] Draw a line.
« [STEP 04) Select an arrow from the brush library 1o apply.
[STEP 05] Adjust stro

B-E- - N — B - - Lol — —
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ke color and thickness to change the appearance.
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Add icons from images using image tracing

= [STEP 01] In this tutorial, you will learn how to convert a raster (bitmap) image to a vector image.

+ [STEP 02) Download a silhouette icon (the black and white image will have the best results) from the image searching
website,

= |[STEP 03] Place the image on the artboard [SHIFT+CTRL+F].

+ [STEP 04] Click [EMBED)] from the [CONTROL PANEL].

« |STEP 05] Click the small arrow by the [IMAGE TRACE)| to select [BLACK AND WHITE LOGO).

Image credit: Block and

white human figures
designed by freepik

[STEP 06) Open [IMAGE TRACE PANEL] to adjust the detail.
« |STEP 07) Once you think the image is ready to convert to a vecter image, click [EXPAND| from the control panel.
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« [STEP 08] Ungroup the expanded image to control the individual object.
« |STEP 09] Remove the unnecessary ohjects.
[STEP 10] Adjust scale and position.

.....

Add texts

+ [STEP 01| Click [TYPE TOOL] from [TOOL PANEL, or press [T].
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« [STEP 02] Create a text box and add texts.

« |STEP 03] Modify fonts and size.
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Export to PDF and JPG

« |STEP 01) Before you create PDF and JPG, you must save the file,

« [STEP 02] To create a PDF file, vou should use [SAVE A COPY] from the file menu = select [PDF] for the file type = select
Adobe PDF Preset [PRESS QUALITY).

« [STEF 03] To create a JPG file, you should use [EXPORT| from file menu = select [EXPORT AS| = select [JPG| for the file
type = click [EXPORT] = select the quality, resolution (150 ppi for low quality print).

l‘ References

Curt, L. (2019, September 30). Quick tip: How to create an isometric grid in less than 2 minutes! Design & Illustration Envato
Tuts+. Retrieved December 22 2021, from https:{desien.tutsplus.com/tutorials/guick-tip-how-to-create-an-isometric-grid-in-
less-than-2-minutes-vector-3831

Pyo, M., & Kim, 5. (2012). Architectural and program diagrams: 1 Construction and design manual(editor [s|, Miyoung Pyo,
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Chapter 4. Depthmap X - Data visualization

Session Objectives

Upon completing this session, students will be able to:

» (CO 1) Understand the concepts of Space Syntax and the examples
» |CO 2) Ready for Space Syntax images
» |CO 3) Generate isovist, connectivity, and gate count graphics

¥ Session Highlights

At the end of the session, students will be able to create the graphics below.

VISIBILITY DIAGRAM ACCESSIBILITY DIAGRAM
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E Lecture Contents

(CO1) Understand the concepts of Space Syntax and the examples

What is Space Syntax

The term space syntax encompasses a set of theories and techniques for the analysis of spatial configurations. [t was

conceived by Bill Hillier, Julienne Hanson, and colleagues at The Bartlett, University College London in the late 1970s to early
19805 to develop insights into the mutually conscructive relationship between society and space. As space syntax has evolved,

certain measures have been found to correlate with human spatial behavior, and space syntax has thus come to be used to
forecast the likely effects of architectural and urban space on users (Wikimedia Foundation, 2021, March 2&).

Spatial layout can create and distribute patterns of collective movement of visitors

Movement traces of visitors in first 10 minutes of
their visil at Tate Britain (Hillier et al 1996)

Three assumptions

1. Spaces can be broken down into components.
2. Spaces can be analyzed as networks of choices.

Visibility analyss of Tate Britain (Source: Space

The image on the left shows
the movement rraces of
wisitors in the first 10
minutes of their visit to
Tate Britain by Hillier et al
in 1904, The image on the
right shows the visibility
analysis of Tate Britain by
Space Symtax Led. image
credie: Hillier et ol & Space
Syntax Lid. Rerrieved from
Sailer, K

3. Spaces can be represented as maps and graphs to describe the connectivity and integration of spaces.
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image credit: Example of
BA BR2 BRI space SYNEEY Fepresentation
of housing floor (n.d)
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E‘nn‘idur.

Three basic concepts in Space Syntax analysis

Convex space

{popularized by John Peponis, and his collaborators at Georgia Tech), an occupiable void where, if imagined as a wireframe
diagram, no line berween two of its points goes outside its perimeter: all points within the polygon are visible to all other
points within the polygon.

An example of comvey
Emmmm - spaces and the depth mop.
D image credie: Dawes, M., 8
! £ ! Ostwald, M. [,

4 B
Convex spaces Justified access graph
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Axial space

iidea popularized by Bill Hillier at UCL), a straight sight-line and a possible path

An example of an axial map
ard the depth map. image
credit: Dawes, M., &
Ostwald, M. J.

Axial map Justified axial map graph

Isovist space

{popularised by Michael Benedikt at University of Texas), or viewshed or visibility polygon, the field of view from any particular

An example of an Isovise
map. image credit: Ostwald
® M.J., Diowes M. [

point

| I—— :
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Visibility Graph Analysis (VGA)

In architecture, visibility graph analysis (VGA) is a method of analyzing the inter-visibility connections within buildings or
urban networks. Visibility graph analysis was developed from the architectural theory of space syntax by Turner et al. (2001)
and is applied through the construction of a visibility graph within the open space of a plan.

Visibility graph analysis was firstly implemented in Turner's Depthmap software and is now widely used by both academics
and practitioners through the open-source and multi-platform depthmapX developed by Tasos Varoudis (Sailer, K, 2016,

February 3.
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An example of Visibility

Floor plan Graph Analysis with using
o depthmapX. image credit:
- 2‘ D e — Sailer, K
- | | -
B Regular grid 1o creale isovists
| 1 .
| o+ X
f "
| B T ]
- | - -
P .
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Edg /
\ T
Construcling a
visibility graph —~—

(VGA)

Why does it matter?

The main proposition of Space Syntax research: the character of social life within a space depends on its position within the
fabric of a city or a building.

Imtegrated spaces: livelier and frequented by more people.

Segregated spaces: lesser frequentation.

Affects the patterns of copresence and encounters in space and thus the patterns of interaction between people (Sailer, K, 2018,
February 3},

Software — Depthmap X

depthmapX is a multi-platform software platform to perform a set of spatial nerwork analyses designed to understand social
processes within the built environment. It works at a variety of scales from building through small urban to whole cities or
states. At each scale, the aim of the software is to produce a map of open space elements, connect them via some relationship
ifor example, intervisibility or overlap), and then perform a graph analysis of the resulting network (UCL Space Syntox, n.dk

« Download the software from the Archtech website.

depthmapX-0.50-64bit-Windows.zip.
Unzip the file and open the [depthmapX 0.50-64bitexe| file.

Mo installation is required for the application,
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(CO2) Ready for Space Syntax images

In arder to simulate in Depthmap X, your drawing needs to be ready for the application.

+ [STEP 01A] If vou use Revit for your project,
Open a plan view(s).
Show Walls, Windows, Doors, Furniture, Built-In Furniture.

Export the view(s) in DWG file format to use in AutoCAD.
« [STEP 01B]If vou use AutoCAD, g 55

Hide all except Walls, Windows, Doors, Furniture, Built-In Furniture layers.

= Copy the elements that show in a separate CAD file.
| ey - R T T DS S ey e e w—

i A i - @
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e e T T e
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+ |STEP 02| If the drawing is simple, you can use the files in depthmap X, but it is recommended to redraw the elements in
separated lavers le.g., 101_S8_A 101_S5_V,
101_55_A layer is for accessibility diagram, 101_85_V layer is for visibility diagram, you can set a different colar for the
layers).

Building envelopi(s) should be closed - 101_85_V laver.

Interior walls should be no thickness (just a single line) - 101_55_V layer.
Doors should be open (no line required).

Interior windows|glassing) should be no thickness - 101_85_A layer.
Furniture {(movable) should not be drawn.

Furniture (stationary) should be drawn in simple lines - 101_85_A layer.

Built-In Furniture should be drawn in simple lines - 101_S8_A layer.
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+ |STEP 03| Create two files by copying the drawn elements.
Omne is for a visibility diagram.

+ Including 101_S5_V laver only.

+ Merge all elements into the [0] laver.

« Use the [Purge] command to clean up layers.
+ Export the file in DXF file format.

[ =] b et b s Sma ey G lmma T Swmm e
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|
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+ Duplicate the DXF file and change the names by level.

b I Lt st y L., nid 1
+ Open the files and delete unnecessary parts (For example, the file is for the 17 level, delete the 2™ level elements).

Chapter 4 Depthmap X - Data visuslizstion | 71



The other is for an accessibility diagram

+ Including both 101_55_A and 101_585_V layers.
« Merge all elements into the [0] laver.

+ Use the [Purge| command to clean up layers.

+ Export the file in DXF file format.
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+ Duplicate the DXF file and change the names by level.
+ Open the files and delete unnecessary parts (For example, the file is for 17 level, delete the 2™ level elements).

(CO3) Generate isovist, connectivity, and gate count graphics

Open depthmapX by double-clicking [depthmapX 0.50-64bit.exe|.

You must click [OK] for the License.

Create a Visibility diagram

+ [STEP 01| Click the [New] icon from the [MAIN| panel to create a new file
+ [STEP 02| Click the [Import] icon from the [MAIN| panel to import [Eames House_85_V-1st.dxf].
+ |STEP 03| Select |[Eames House_S5_V-1st.dxf] file and click [Open].
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+ [STEP 04] Click the [Set Grid| icon from the [Main| panel to create grids. The software will analyze vour drawing within/
by the grids that vou created.
The spacing can be smaller, can be larger. If vou set the grid smaller, you will get better graphics, but it will take more
time; sometimes, you may get an error. If vou set the grid larger, vou will get low-guality graphics, but it will speed up
your work,
Tips, If the profect size is considered in a big-size project, double up the number you get from the defaule. If the profect size i
PS, I j" CT 512 15 considered 1n a Mg SlZe .I roject, aoubie Ilr g mum ir_. ol Ie{.l _f. am e .h_.l]ll i i e j rofecr S1Z€ 15

considered in a small-size project, use the number thar the software provides,

AlEntetwel i o &

+ [STEP 05] Once the grid is set, click the |Fill] icon (looks like paint bucket) from the [Main| panel to designate the area

you want to analyze = Click one of the grids that vou want to analyze.
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« [STEP 06] Click [TOOL| from the menu = Click [Visibility] » Click [Make Visibility Graph..] = Uncheck all from the
options = Click |OK] = You will get [Connectivity] result.
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« |STEP 07) In order to get the visibility diagram, Click [Tool| from the menu = Click [Visibility] > Click [Run Visibility
Graph analysis| » Check |Calculate visibility relationships], Check [Include global measure|, enter [n] for |Select radius|

the Analysis options = Click [OK] = You will get [Visual integration| result.
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« [STEP 08] If vou want to change the background color and line color, click the [View| menu = Click one of the menus=
Change the setting. You also turn on/off the grids.
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+ |STEP 09] As far as | know, there is no export function on this software. Sa, it would be best if you screened capture to
use the image. | recommend overlaying with the floor plan in Photoshop.

Chapter 4. Depthmap X - Data visuslization | 75



—

"II-.._'
'I-..._.“‘-

L

Create an Accessibility diagram

= [STEP 01| Click the [New] icon from the [MAIN| panel to create a new file.

« [STEP 02] Click the [Import] icon from the [MAIN| panel to import [Eames House_55_A-1sc.dxf].

« |STEP 03] Select |[Eames House_S5_A-1st.dxf] file and click [Open|.

= |STEP 04| Click the [Set Grid] icon from the [Main| panel to create grids.

« [STEP 03] Once the grid is set, click the [Fill] icon (looks like a paint bucket) from the [Main| panel to designate the area
you want to analyze = Click one of the grids that vou want to analyze.

= [STEP 0&| Click [TOOL| from the menu = Click [Visibility] = Click [Make Visibility Graph..] > Uncheck all from the
options = Click [OK] = You will get |[Connectivity] result.
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« [STEP 07) In order to get the accessibility diagram, Click [Tool] from the menu = Click [Agent tools| » Click [Run Agent

analysis| = Default serting is okay, no change needed. But if you want to try different settings - Movement rule, Analysis
length, and checking [Record trails] = Click |OK] = You will get [Gate Counts| result.
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= |STEP 08] This is the final result after photoshop.
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PART TWO. HYBRID DIGITAL DRAWING

Chapter 5. Wacom tablet & Painter - User interface

+  Be aware of various types of perspectives using hybrid techniques

« Be introduced Wacom tablet technology

« Be introduced “Painter Essentials” and similar applications in the industry
* Understand the basic interface of “Painter Essentials”

Chapter 6. Painter — Tools and brushes

«  Four types of working in Painter
+ Use basic tools and panels in Painter

» Understand brushes in painter - Choosing and acquiring brushes

Chapter 7. Painter — Auto painting & Clone painting

+ Various brushes and categories
= Al puto-painting

+ Clone painting

Chapter 8. iPad & Procreate

» Beintroduced a drawing app - Procreate

+ Understand the basic interface and gestures of “Procreate”

« Understand various brushes, layers, and colors

«  Understand various tools in the app

+ Be introduced various working processes for perspective views
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Chapter 5. Wacom tablet & Painter - User
interface

Session ':1!1.|L'L'[j'l s

Upon completing this session, students will be able to:

» [CO 1) Be aware of various types of perspectives using hybrid technigues
« (CO 2) Be introduced Wacom tablet technology
« (CO 3) Be introduced “Painter Essentials” and similar applications in the industry

+ (CO 4} Understand the basic interface of *Painter Essentials”

E Lecture Contents

(CO1) Be aware of various types of perspectives using hybrid techniques

Architectural illustration styles

There is no doubt that digital culture has changed the way that projects have been designed and represented, according to
Perry Kulper, author of “The Labor of Architectural Drawing," the result is a “shift from what architecture looks like to how it

behaves—a movement from the configuration and image dominance to parametric and performance logics.”

However, despite their waning appearance in the business-as-usual side of architecture, drawing and illustration are still
inescapable components of the practice that filter into muoltiple stages of the process (Garkavenko, A, 2021, December 9).
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ASAI (American Society of Architectural Illustrators)

Image credic ASAL

Founded in 1986 in the United States, the ASAI is comprised of professional illustrators, architects, designers, teachers,
students, corporations, and anyone engaged in the serious pursuit of architectural illustration. The central purpose of ASAI

remains the improvement of architectural drawing worldwide.

DCA (Design Communication Association)

image credic DCA.

e
e

The Design Communication Association (DCA) is an international professional society composed of graphics/design teachers

from schools of architecture, landscape architecture, interior design, graphic design, and product design.

For more resources for architectural illustrations, check out the illustration tag on the Archdaily website.
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Working Processes

Use a photo as a base for the drawing

Example 1

This archirectural
perspective image is the
final illustration based on a
photo that the author ool
This image depicts the
Korean rradirional
architecture
(Gwanghwamun-a front
gate of the Joseon Dynasty's
palace} withour disterting
the '.uru'.ih:'ng point.

TITLE GWAMGHWAMLIN Award of Excellence In the observational category of the 34th
amnual Architecture in Perspective Intemational Architectural

TVHE NON-COMMISSIOHED ART llustration Competition
YEAR 2018

SIXE 40 X 50 en

MECILM WACOM TABLET, DIGITAL

Example 1 Process

Chapter 5. Wacom tablet & Painter - User interface | 83



Example 2

Example 2 Process
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These four images in a row
show the working process of
the Gwanghwamun. The
first image shows the photo
base with the lines that 1
traced. The second image
shows tming off the photo
layer and adding more
details and some colors,
The third image show some
graphic experimental to
show the details. 1 added a
paper texture layer as a
background and change the
darkness of the paper
textre only en the
architecture part. The last
image shows turning off the
paper fexrure image a
adding more details with
thin lines and dos,

This illustrarion is also an
example of a photo-based
digital drowing. This image
shows rwo truck groffaei on
the ourside of a wall that [
rook a picture of from
Brooklyn, New York.



Use a 3D (rough) rendered image as a base for the drawing

Example 1

Example 1 Process

e

Mparnd ‘flosaakl Yemsds Jumors Awmard of Merlt’ st
American Society of Architectural Fustrators

—
=

These process images show
how I draw this digital
illustration. The first image
shows the original photo
that ! took. The second
phoro shows the ourines of
the photo that I traced. It
shows the original image in
the back layer. The third
image shows how I add
colers and the rruck graffici
on the outside wall. The last
image is the final result of
this work,

This interior perspective
view presenes the cowrtyard
of the future af the Stahl
house project that § worked
on in 2015, The site locates
in Los Angles. This image
was based on a
coemputer-generated 30
rendering Because this is a
hypothetical profect, I
necded o based image to
visunlize the profect. With
3D rendering, the
illustration looks more
realistic, but the line
drawing cxpresses a more
[fomtasy feeling.
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These three images show the
process of the work above,
The first image is the
computer-generated 20
rendering. I used 3Ds Max
and Vray for the rendering,
The second image shows the
outlines of the illustration
based on the rendering, The
last image is the final result
of the work. I added all of
the detail lines and remove
some urmecessary objects
and added some that 1
missed in the modeling
process.

—
—_—
—

3

Example 2

This digital rendering was a
commissioned work. A
client asked me o drow the
three buildings in a
perspective rendering. The
client provided the
three-building sepamtely.
Then I photoshopped the
three blf:'fdings I:flll::l:lr[l:'
view and changed the
buildings vanishing points
to look more harmonized,
and added the sky. With the
client's uppmu!, I draw the
image and connect the
image mare naturally, And
also [ matched the color,

i

._l::
By
- 19
i !

_'-rr-r;I

Example 2 Process
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These six images explain the
process of the perspective
rendering image above. The
first image on the lefr top
shows the three-building
images that the client
provided. The second image
shows the lecation where
the client wants ro add the
three buildings. The third
image shows the
photoshopped image that
the client approved, The
fouerth image shows the
outling of the three
buildings and surroundings.
The fifth image shows the
background cloud added,
The last image is the final
rendering with the buildings
and surrounding color:

Use a sketch or a hand-drawn image as a base for the drawing

Example 1
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TTLE IOWA STATE LNWERSITY 4

TYFE NON-COMMISSIONED ART

YEAR 2018

SIZE 27X 21em

METHUM WATERCOLOR. PEM AND BNK, DIGITAL

2018 Design Communication Association Juried
Exhibition in observational image category, mixed
imedia with watsrcolor

This last image is an
example of a hybrid
perspective. I draw the Towa
Stare University building as
o course project. With :Ef
profiessor’s
recommendation, I added
some images on Adobe
Photoshop like human
figures ond plants ond
dawlighting which are
usmally difficult to express
on warercolor drowings.

(CO2) Be introduced Wacom tablet technology

Wacom Co. Ltd is a Japanese company that specialized in Graphic Tablets and related products since 1983,

Wacom provides 3 product lines:

Pen computers
Pen displays
Pen tablets
Smartpads
Srylus

N
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image credit: Wacom

Wacom Intuos Tablet Features

« Customizable ExpressKeys: Four keys on the upper corners of the Intuos allow you to set frequently used functions or
keystrokes, or simulate button clicks or modifier kevs.

» Touch toggle switch: This allows you to enable or disable touch.

«  USB connector: Connects your [ntuos to vour computer. See the Quick Start Guide thar came with your Intuos for
instructions on connecting it to your computer.

» Power LED: Lights when the Intuos is connected to an active USE port.

«  Status LED: Lights when you touch the active area, or use the pen or ExpressKeys™,

+ Active area: The portion of the Intuos surface that detects pen and touch input. The boundaries of the active area are

shown by four small dots on the corners of the tablet.

image credit: Wacom,
bt Ham

¥ teroasgh 4 Eapresskopgs ™

Power LEL
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Pasn hioldes

] Towch ondalt swrtch fmgnl rear oomearn

Shatun LED
1o At driss
Wacom Intuos Pan Features
»  Matural feel with 40% Pen pressure sensitivity.
+  +f-0.25mm digital tolerance in accuracy.
+ Mo battery required pen.
» 7mm reading height.
—_ - image credit: Wacom
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Wacom Tablet Properties

Open your Contrel Panel

Select Wacom Tablet Properties

W Tablet PC Settings Taskbar and I

-
%
[
" Windows Del
Tablet P ‘
nts &P Wacom Tablet Properties Firewall
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Test pressure and settings

¥ Wacom Tablet Properties = X
pevice < | 5
Infupzd M
Tool; < ! / # I
Functions Grip Pen ES
]
Application: |« A N
All
Pen Eraser Mapping
Tip Feel Tilt Sensitivity
L v
Soft Firm Normal High
I Customize...
Double Click v
Current Pressure |
|
Click Maximum — Right Click ~
Tip Double Click Distance
L
* * L] L L click
Off Large
 Default |
About Options... (7]
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ExpressKeys setting

# \Wacom Tablet Properties =

Device: -
Intuosd M
Took E /
Functions Gnp Pen
Application: A
All
ExpressKeys TouchRing Display Toggle On-Screen Controls
Settings v
Raclial Menu v /’/
Modifier...
Precision Mode... v Shift
Modifier...
Display Taggle ~ Ctrl
Modifier...
Alt
R Fan/Scroll.,
Default
About Options...

8 Productivity Tips for your Wacom tablet

Optional read and watch this blog post for Productivity Tips for your Wacom tabler.
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(CO3) Be introduced “Painter Essentials” and similar applications in the
industry

Corel Painter is a raster-based digital art application created to simulate as accurately as possible the appearance and behavior
of traditional media associated with drawing, painting, and printmaking. It is intended to be used in real-time by professional
digital artists as a functional creative tool.

The application offers a wide range of traditional artists’ materials and tools. With the aid of a graphics tablet or computer
mouse, the user is able to reproduce the effect of physical painting and drawing media such as wartercolor, oil, chalk, charcoal,
and color pencil. There are also a few non-traditional items, such as the Image Hose, pattern pens, F/¥, Distortion, and Artist

tools for allowing artists to apply less conventional elements to an image.

Painter Essentials 7

Painter Ezsentials product wehbsite link
Painter Essentials 7 (Windows/Mac) [ttt

Painting software for beginners

User-friendly interface
Al-based photo painting
Industry-acclaimed brushes
Incredible speed

Built-in leaming

Painter 2021

Fainter 2021 product website link

image credit: Corel Painter

NEW Painter 2021 2021

[.'r: HEeLS i-_ ] .-'_|; | 131t ng q

Prof nal blank canvas painting and photo-art tools

World-class Notural-Media™ emuiation & digital art brushes

Urdimited customization of brushes, lexdures, and other media

Mac & PC support, FREE brush padks and more (Subsoiption onlby)

Similar applications

Autodesk Sketchbook website - Sketch
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image credit: Skerchbank
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image credit: Adobe
Photoshap

Creativity is everywhere.

Now Photoshop is too.
Students, get Photoshop s part of Creative Clowd fior S04

Affinity Photo - Sketch, photo edit, rendering retouch

image credie Affinicy photo

Beautiful brushwork
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(CO4) Understand the basic interface of “Painter Essentials.”

Welcome page

+ Documents - New, Open, Recent Documents

+ Layout - User Interface
+ Turarials

+ Instagram

+ Tech supports

Create a new document

= |STEP 1] Click |File] = Click [New] ar, Press [CTRL = N|

+ [STEP 2| Select [New Document)

+ |STEP 3] Add Filename, adjust Resolution, and add with size with the right unit, change the color of the background, and
paper texture.

Save the file

Press [CTRL + 5]
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Workspace

MEMU

DRAWING AREA

Preferences
[ Qe
General Eabiet Oxitiors
Imterface
Performance =} ‘Wacom-compatible deviee [(Wintah)
Tubsket I} AT3-compatible device (Real-time Styhes)

To change teblet options, you miat restert Cored Painter Basentiale

Mults-touch Dptasms:

i Enable Multi-toush

® Cored Pamter Essentiads Mutt-touch (requires Wacom-compatible device)
! Windows Mulkti-touch
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Chapter 6. Painter - Tools and brushes

Session Objectives

Upon completing this session, students will be able to:
» (CO 1) Four types of working in Painter

» (CO 2) Use basic tools and panels in Painter
» |CO 3) Understand brushes in Painter - Choosing and acquiring brushes

‘¥ Session Highlights

At the end of the session, students will be able to create the graphics below.
image credit: The base
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E Lecture Contents

(CO1) Four types of working in Painter

Drawing and painting from scratch
Many digital artists start to draw on the Painter artboard directly without any guidance. But this needs many practices, so
beginners are not recommended to use this type of work in Painter.

However, [ think this “drawing and painting from scratch” might be a suitable method for concept sketches of your design

work.

The painter supports a variety of sizes of the artboard, paper for texture, brushes, and colors from the color wheel and
swatches.

Painter brushes can paint or draw with any media - not just oils and watercolor, but also pencils, pens, pastels, markers, and

other media.

image credit Stacy, R,

Tracing an image
You can use tracing paper to outline an image or ather renderings. You can then use the outline as a starting point for a
painting.

This is a helpful method for designers/artists who want to draw perspective drawings with the right vanishing point and

viewpoint lines.

After vou trace the outline, you will use various brushes to express drawing in the artistic matter.
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image credit The base
photo is o modified image
from edbridpge.

Painting by hand using Photo painting brushes

Painter has a unique technology to copv images with different brush styles. It calls Photo Painting Brushes.
You can express the color and details with different media, like oil paint, pastel, chalk, spray, watercolor, pencil, and more.

COne tip from the Painter Essentials quick start guide: “Don't attempt to paint every square inch of the canvas. Allowing some
of the canvas to show through adds to the loose, fluid quality of the image. Don't be concerned abour slight overlaps with
adjacent areas, The basic idea is to work quickly and with spontaneity.”
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2000 Practic ol desgn Competition

HYUN-DAI STEEL main gate project

AT Auto-painting

“A great way to become acquainted with Corel Painter is to create photo art by painting on an image (photo or rendered image).

Based on the analysis of a large number of paintings by different artists, the Al presents the use of advanced machine-learning

technigues to create auto-paintings that match more realistically the aesthetics and painting styles of professional artists.

Image credit: Corel

H Discovery Center

|~ Rl
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(CO2) Use basic tools and panels in Painter

Tools

+ Brush tool lets vou paint and draw on the canvas or a layer.

»  Dropper tool lets you pick up a color from an existing image.

«  Paint Bucket tool lets yvou fill an area with color,

+  Text tool creates text shapes.

+ Eraser tool lets you remove unwanted areas from an image by using brushstrokes.

«  Crop tool lets you remove an unwanted area from an image by cutting them out.

+ Rectangular selection tool.

» Owval selection tool.

+ Lasso selection tool.

+  Magic Wand tool lets select an area of similar color by clicking or dragging in an image.

» Selection Adjuster tool lets vou select, move, and manipulate selections created with all selection toals.
«  Transform tool lets you modify the selected area of an image by using different transformation modes.
« Layer Adjuster tool is used to select, move, and manipulate layvers.

» Rubber Stamp tool gives you quick access to the Straight Cloner brush variants.

«  Dodge tool lets you lighten.

+ Burn tool lets vou darken.

»  Mirror paint mode lets you create a perfectly symmetrical painting.

«  Kaleidoscope mode lets you transform basic brushstrokes into colorful and symmetric kaleidoscope images.
+ Grabber tool lets you pan through an image quickly.

»  Magnifier tool lets you magnify areas of an image.

«  Rotate page tool lets vou rotate an image window to accommodate the way you naturally draw.

« Color selector lets vou choose main and additional colors.

» Paper selector opens the papers flyout.

+ Color tools.

+ Text, Eraser, and Crop tools.

« Selection tools.

+ Photo tools.

+  Symmetry tools.

»  Mavigation tools.

+ Selectors.

Panels

« Photo Painting: Provides all the tools you need far creating photo art.

= Mixer: Lets you mix and blend colors as you would on the artist’s palette.

«  Color Set: Displavs the colors in the current color set so you can organize groups of colors.

« Navigator panel: This Lets you navigate the document window without zooming out.

= Layers: This lets you preview and arranges all layers in the document. You can set the composite method, adjust the
opacity, and lock and unlock layers.
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(CO3) Understand brushes in Painter - Choosing and acquiring brushes

Choosing brushes

The Brush Library panel lets you choose brushes from different brush categories.

Brush categories are groups of similar brushes and media.
Brush variants are specific brushes within a brush catepory.

To select a brush variant

« |STEP 1] Click Brush tool

= [STEP 2| Click Brush selector

« [STEF 3| Click a brush category in the brush library
« |STEP 4] Click a brush variant

Adjusting brush settings

« |STEP 1] Adjust the size of the brush
« |STEP 2] Adjust the opacity of the brush
« |STEP 3] Adjust the grain of the brush
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Practice Wacom tablet with [Pen] or [Pencil] brush.
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Chapter 7. Painter - Auto painting & Clone
painting

Session Objectives

Upon completing this session, students will be able to:

» |CO 1) Various brushes and categories
« (CO 2} Al auto-painting
« (CO 3) Clone painting

‘¥ session Highlights

At the end of the session, students will be able to create the graphics below.
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E Lecture Contents

(CO1) Various brushes and categories

Acrvlic and oils

The Acrylic brush variants are versatile brushes that let you apply quick-drying paints to the canvas,

The Oils brush variants let vou create effects you'd expect from oil paints. Some variants are semi-transparent and can be
used to produce a glazed effect.

vo 4

Airbrushes

Alirbrushes apply fine spravs of color, which mirror the feel of a real airbrush in action. Most airbrushes support color buildup
on a single brushstroke.

> »l
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Artist

The Artist brush variants help you paint in the styles of master artists {(Van Gogh, Impressionist Blender, and Sargent
Brush|.

Photo Painting Brushes

Although you can use any brushes when auto-painting a photo, the Photo Painting brush variants are specifically optimized
for auto-painting.

Blenders

Blender brushes affect underlying pixels by moving and mixing colors. The brushes can reproduce the effect of blending paint
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by applying water, vil, or knife.

Chalk, Pastel, & Crayons

Chalk brush variants produce the thick, rich texture of natural chalk sticks with the paper grain.

Pastels range from hard pastel styles that reveal the paper grain to extra soft pastels that glide on to completely cover existing

strokes.

Crayons offer a range of styles from soft and dull to waxy and grainy.
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Dab Stencils

The Dab Stencil brush variants knock out the area of the brush dab by making them more transparent. They use stencil
media, such as papers and flow maps.

LA

Digital Watercolor

Digital watercolor brush variants produce watercolor effects that react with a canvas texoure and allow colors o flow, mix,
and absorb more realistically.

X
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Dynamic Speckles

Dynamic Speckles brush variants generate a continuous brushstroke from discrete spots of the color of speckles,

F-X

F-X brush variants can give you an array of creative results. Some add color. Others affect underlying pixels.

Glazing Brushes

Glazing brushes can help you fill an area with long continuous strokes that have a very soft gradation from the beginning of
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the mark to the end.

Particles

Particle brushes are physics-inspired brushes that give a unigue look and feel to your artwork.

Pattern Pens

Pattern Pens brush variants let you use a brush to apply a pattern to an image.

Sponges

Sponges let you create a variety of textures by applying the current paint color or blending existing colors.
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(CO2) Al auto-painting

A unigue way to create a custom drawing with Corel Painter Essentials 7 is to use Al auto-painting,

Based on the analysis of a large number of paintings by different artists, the Al presets use advanced machine-learning
technigues to create auto-paining.

Al auto-paint

+ |STEP 1] Open an image that you want to turn into a painting by clicking [BROWSE] on the [PHOTO PAINTING| panel.
Note. Befare you open the image, please confirm your canvas size and the image size are the same. Confirm the sizes of the images

by pixels.

—y ey ——

|y N——

+ |STEP 2| Choose a preset style from the pop-up menu.

« [STEP 3] Add a new layer.

+ |STEP 4] Click the [START] button.
Note. It rakes time to start, abour 1-3minutes depending on your computer hardware spec.
Note. The auto-paint stops automatically when the painting s finished. Or it stops when vou choose a different application. To stop
the auro-painring earlier, click the Stop button,
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You can apply any finishing touches by hand.

W b e L Ham o

You also can add other auto-paining on the top of the layer, but use a separate layer to add other auto-paint and adjust layer

styles and transparency.

B e b || g, 6 o 5 |
Pia lil Ceen s bl Pl Sk

Please experiment with different brushes, paper textures, other settings.

114 | Chapter 7. Painter - Auto painting & Clone painting



To apply surface texture

-

[STEP 1] Duplicate the layers.

[STEP 2] Merge the copied layers into one layer.

[STEP 3| Click |Effects| = Click |Surface Contral] = Click [Apply Surface Texture.
[STEP 4] Adjust paper, amount, and other values.

[STEP 5] Click JOK] to apply.

-

-

P e 1 e sy e e e

(CO3) Clone painting

This clone painting allows you to paint some selected areas by using quick, loose strokes. Please don't attempt to paint every

square inch of the canvas,

You can experiment with different brushes from the [PHOTO PAINTING BRUSHES| category to achieve different styles.

To make a clone painting

[STEFP 1] load a base image that you want to paint by clicking [BROWSE| from the photo painting panel.
[STEP 2| Press [CTRL + T| to turn on and off the base image, you can adjust the trace paper opacity.
[STEF 3] Select a variant from the Photo Painting Brushes,

|STEF 4| Draw on a new layer.

-

-

-
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Chapter 8. iPad & Procreate

Session Objectives

Upon completing this session, students will be able to:

» (CO 1) Be introduced a drawing app - Procreate
» |CO 2) Understand the basic interface and gestures of “Procreare”
» |CO 3) Understand various Brushes and color

(CO 4} Understand various tools in the app
» |CO 5) Be introduced various working processes for a perspective view

E.’ Lecture Contents

(CO1) Be introduced a drawing app - Procreate

FProcreate - App

“Procreate is a raster graphics editor app for digital painting developed and published by Savage Interactive for 105 and

iPadOS, Designed in response to the artistic possibilities of the iPad, it was launched on the App Store (i0S} in 2011,

The aim of Procreate is to recreate the natural feel of physical drawing while utilizing the practical advantages of a digital
platform. [t offers over 130 cuscomizable brush presets, multiple layers, blend modes, masks, 4K resolution export of process
videos, autosave, and many other digital art tools. In addition to raster graphics, this software has limited abilities to edit and
render text and vector graphics. Procreate is designed for multi-touch and the Apple Pencil. It also supports a number of third-

party styluses, and imporg/export to Adobe Photoshop. PSD formart,

Procreate does not require in-app purchases or any form of subscription (Wikipedia, 2021).

Procreate for architects

10 Immediate Reasons for Architects & Designers to Use Procreate (James Akers, 2020,
» Your iPad is your sketchbook for the digital age
 Layers act like tracing paper

+ The select and move tool
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+  Quick lines and guick shapes

« Perspective and 2-D grid drawing assist

« Coloring with the select and fill method

«  Artistic brushes

« Hue, Saturation, and Brightness

« Blending Modes

« How Procreate pulls everything together in one place

(CO2) Understand the basic interface and gestures of “Procreate”

User Interface

There are two types of interface in Procreate. One is a gallery, the other is a project.

Gallery

In the gallery, you can create a new project, organize your projects, share the projects in different formats, and import photos
from iCloud and your photo to start vour project.

Organize your projects — Select, delete, duplicate, rename, and stack.
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PI’DCI’EEtE Select  Impor Photo

Create a new project.
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Procreate

New canvas

Screan Slze 73 1224 s tésHpr
Souare RGE 2040 = 20480k
Fild RGE  A0%6 = 17 Tdgw
A [Ce7] 710 = 29TFmm
4 x & Photo FE & ad’
Faper WRGE 1 =85
Comic CMYK [SLE s
Untitled Canvas P3 1999« 15011em

Untitled Canvas

A677 & HEFTON
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Custom Canvas Last-first name-EX2

2 Dimensions
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CUS’(DITI CEI“UES Last-first name-EX2

-
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Codar profile
Generic CMYK Profile
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CUEt'DITl Canuaﬁ Last-first name-EX2

1920 = T080px

Time-lapae setlings

Select and share a project in different formats.
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Procreate
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prﬂCrEEtE Praview Share  Duplicate  Delete

Import photos/images from iCloud.

Project (called artwork or canvas)

Project is a working arena of your artwork. There are three main parts to the interface. Fainting Tools on the top right, Sidebar

on the left side, and Editing Tools on the top left.
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Fainting tools

+ Paint

+ Smudge

+ Erase

+ Layers

« Colors
Sidebar

+ Brush size
«  Modify button
» Brush opacity

« Undo/Redo arrows
Editing tools

« Gallery
+  Actions
«  Adjustments

+ Selections
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+ Transform

Gestures and Apple pencil

Gestures

Based on the instructor’s experience, using an Apple pencil will get the best result in paint/smudge/erase because of the
pressure and tilt sensitivity. But except for these three, using your figures will ger the best controllability on the application.

+ Pinch to Zoom

+ Pinch-twist to Rotate

« Quuick pinch to Fit to screen

+ Two-finger tap to Undo

+ Three-finger tap to Redo

+  Three-finger scrub to Clear

« Three-finger swipe to Cut/Copy/Paste

«  Draw and hold for QuickShape

+ Hold a layer to Move the layer or Group the layer with another layer
+ Two-figure tap on a layer for Layer Opacity

(CO3) Understand various brushes, layers, and colors

Brush Library for Paint, Smudge, and Erase

» Paint - Sketch, ink, paint, color, shade, and texture in a variety of mediums,
« Smudge - Blend your arowork, smooth out strokes, and mix calor.
+ Erase - Paint away mistakes, remove pigment, carve out areas of transparency, and soften your artwork.

« |STEP 01| Confirm the current layer.
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= |STEP 02] Tap the brush tool = Select a brush set from the Brush library > Select a Brush,
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Brush Library

= |STEP 03] Select color from the Colors tool,
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Colors

» |STEP 04| Check the size and the transparency of vour brushstrokes
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Brush Sers

The left panel of the Brush library lists the Brush Sets sorted by medium style.

Custom Brush Sets

You can create your own Brush sets by tapping [+] on the top of the Brush sets and dragging and dropping on the settings vou

made,
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Brush Library

Technical Pen

=

Duplicate

Import Brush Sets

You can also import Brush Sets that vou purchased and downloaded. There are many great brush sets for Procreate users.
After vou download the brush set file (filename.brushset) on your iPad, you can import the set by opening the file. The set will

automatically import to your Procreate.

Please refer to Creative Market's tutorial on installing Procreate brushes for more information.

Lavers

Background color

calor layer. If you want to make a transparent image, vou can turn off the visibility,

Tip. Typically, the instructor adds a textured background image (e.g. watercolor paper, canvas, or craft paper) on a vary bottom loyer and

locks the layer ro prevent any occidents,
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Layers

- & Paper Texture

Layers

Layers let vou stack image elements on top of each other and adjust the element much easily. You can create a new layer by

tapping the [+] on the top right corner of the Lavers panel.
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Layers

Layer 2

If needed you can move by holding the layer

If needed vou can lock, duplicate, and delete the layer by sliding the layer to the left side.
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Duplicats SRS

Once you tap the layer thumbnail, vou have more options for the layer.
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Layers

Copy
Fill Layar Layear 2
Clear
n Lock
Masl
Clipping Mask
Invert

Retfare

If vou adjust the transparency of the laver or change the layer blend mode, tap the current blend mode. By default, Normal
mode is active, shown by the letter "N
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Multiply

Colors

Select, adjust, and harmonize the color in your art.

Once you tap the active color on vour screen, the Color Panel will open. There are four modes of the panels - Disc, Classic,
Harmony, and Value.

You can select color one of the modes that vou are most familiar/comfortable with.
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Split Complementary CG |0f5

Trindic

Tetradic

Additionally, vou can use Palettes. Procreate also save the previously selected color on the History. You also can create a color
palette in your own selection and from an image.
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Palettes

. Create new palette

ey Trom chmera

Mew from file

Mew from photos Eal

Defaul

If needed, vou can fill color in a closed object by dragging and dropping off the color to the closed object.
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(CO4) Understand various tools in the app

Actions

Actions menu has all the practical features you need to insert, share, adjust your canvas and any of the elements within it.

Add tab
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>

Actions
m U » ©

Add/edit text
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Halvatica
ehica Meis
Hiragina Mamu Gothic P

Edit text layer
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Style

Regular
Obligue

Laght

Bold Obiique

Kerning

lracking 0.0%

Leading

Opacity

Import Font

Attributes




Layers

Halla

Edit text as an image
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W Usiform

Canvas tab

In the canvas tab, you can adjust the size of the canvas, add a drawing guide (3D, ISO, 1 point perspective, 2 points perspective,
and 3-points perspective), add a reference image on a separate window, and more.

Drawing Guide
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>

Actions

Edit Drawing Guide

Chapter 8. iPad & Procreate | 145



Drawing Guides

B Pempsciive

Activate Drawing Assist from the layers
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Fill Layar

Clear

Alpha Lok

Munk

Clipping Mask

Draw lines with the Drawing Assist function
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Reference
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Actions

Share tab

Share your work in a variety of image formats.
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Actions

o

Share image=

Share Layers

Video tab

Record your work process to a Time-lapse video and share it
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Actions
m a

Preferences tab

Customize the workspace to suit your workflow.
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Adjustments

Adjust your image with Sharpen, Noise, Blur, Color changes, apply effects like Liquify, Bloom, Glitch Halfrone, and Chromatic.

You can apply these adjustrments to a layer ar with a pencil tool.
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F

Adjustments

Hue, Saturation, Urig.phlr'lrj*:'_.':.

Selections

If vou need any part of your image to control, use this selection tool
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Transform

Stretch, move, and manipulate any part of your image for fast and easy edits.
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W Usiform

Tip. You also can use the ransform tool for the seleceed area only.
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(CO5) Be introduced various working processes for perspective views

Below five videos present the working process of the digital drawings. The author tried to use different mediums for each

drawing.

iﬂne or more interactive elements has been excluded from this version of the text. You can view them online here:

| T A A, I o= L

1One or mare interactive elements has been excluded from this version of the fext. You can view them anline here:
E.'Ji'tus;fr'r&srare pressbooks pubiisualgraphiccomma2Fp=61 Ffoembed-2

iﬂne or more inferactive elemenis has been excluded from this version of the fext. You can view them online here:
|
lhitps iastate pressbooks pubATsualgraphiccomm2/7p=61 Tfoembed-3

?Cl'ne or maore interactive elements has been excluded from this version of the text. You can view them online here:
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One or more interactive elements has been excluded from this version of the text. You can view them online here:
hitps Aiastate pressbooks. pubivisualgraphiccomma/To=61 Ffoembed-5
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Wikipedia 2021. Procreate (software) - Wikipedia. [online|, Accessed 7 September 2021, hups:lenwikipediaorpgiwikif

Procreate I:Sﬂfﬂ‘-"ﬂl'f.‘:'.
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PART THREE. ADVANCED MODELING

Chapter 9. Revit — Family parameter

+ Understand parameters in Revit family modeling
« Create a simple chair with parameters

« Create a simple table with parameters

Chapter 10. Revit - Nested family

» Understand a nested Revit family and how it works
« Create a chair and table set with nested Revit families
«  Modify a door family

Chapter 11. Revit - Organic shaped walls

+  Create a slanted wall without Massing tools

+ Understand various 3D models using Massing
= Create an organic shape wall

« Create an organic shape curtainwall

Chapter 12. Revit - Organic shaped ceiling and column

« Create an organic wooden pattern ceiling/wall/bench
+ Create a geometric pattern ceiling
« Create organic column vs. geometric pattern column

Chapter 13. Revit — Sketchup models

+ Create an advanced Revit Site model (Surroundings)
» Import Sketchup models in Revit project with material changes
«  Import Sketchup models in Revit project without the complex lines using 3Ds Max

Chapter 14. Sketchup advanced modeling

« Understand the process of a Revit model to a Sketchup model for rendering
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+ Understand the Sketchup modeling process and strategies

« Understand Sketchup advanced modeling with plug-ins
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Chapter 9. Revit - Family parameter

Session Objectives

Upon completing this session, students will be able to:

» (CO 1) Understand parameters in Revit family modeling
» (CO 2) Create a simple chair with parameters
» |CO 3) Create a simple tahle with parameters

‘¥ Session Highlights

At the end of the session, students will be able o create the graphics below.

o Viewi ®

g
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rere’ 5@ EE ST v - ra O EE R

E Lecture Contents

(CO1) Understand parameters in Revit family modeling

About Parameters

You can create parameters for a project and any element or component category in the project.
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Parameters that you create display in the Properties palette or Type Properties dialog under the group vou define and with the
values you define.

For more information about Revit Parameters, please read this guide on Revit Parameters from Autodesk.

Fam ify Parameters

Family parameters control variable values of the family, such as dimensions (Width, Height, and Depth) or materials. They are
specific to the family.

A family parameter can also be used to control a parameter in a nested family by associating the parameter in the host family
to the parameter in the nested family.

By adding new parameters, vou have more control over the information contained in each family instance or type. You can
create dynamic family types for increased flexibility within the model.

For more information about Revit Family Parameters, please read this guide on Revit Family Parameters from Autodesk.
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(CO2) Create a simple chair with parameters

In this tutorial, students will practice creating a simple chair family with parameters that can change the dimensions and
materials.

To create a simple chair family

= |STEP 1] Open |Revit] Application, In this tutorial, the instructor use Revit 2021,
« [STEP 2| Click [New .. | under |[Families| category on the [Welcome| page.
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« [STEF 3] Open [English-Imperial| folder, select [Furniture.rft], and click [Open], then vou will see the four views. Make a
tile window view [WT] to see all
[Save| the file before you start. [First_Lastname_EX3_Chair].
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|STEF 4] Select |[Reference Plane| from [Create| tab, under |Datuml|.

[STEP 5] Draw four lines near the center lines on the [Ref. Level| plan view. The center lines are locked—these four lines

for the overall width and length of the chair. You do not need to draw the reference plans precisely.
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« |STEP 6| Click |Aligned Dimension| from [Annotate] tab, under |Dimension|.
or, type |D1] and create dimension for overall all dimensions and the center dimensions with Equal.
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« [STEP 7| Click the overall width dimension click [Parameter Properties| from [Modify/Dimensions), under [Label
Dimension].
Then add Name [Chair-Overall-W] and click [OK] w finish.
Repeat this step for [Chair-Owverall-L].
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+ [STEP 8] Add reference planes for heights.

= Select [Reference Plane| from [Create| tab, under [Datum| panel
or, |[RP|.

= draw two lines on the [Front] view.

= add dimensions for [Chair seat height] and [Chair overall height].

= define the parameter name on [Parameter Properties|.

= Chair-Sear-H.

= Chair-Overall-H.
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« |STEP 9] Add reference planes for the seat depth = 2" and the seat back depth=1".
make dimensions for the depths with lock, but do not define the name,
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« |STEP 10] Add reference planes for chair leg thickness.

= Make dimensions for the leg thickness.

= Select the four dimensions together.
= Click |[Parameter Properties.

= Add Name [Chair-leg-T].
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Now you are ready for modeling. If needed, please update the scale of the view.

« |STEP 11] Click [Extrusion| from the [Create| tab, under the |[Forms| panel, and draw lines to fit the overall dimension of

the chair and lock all.
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+ [STEP 12] See the front view and update the seating height by adjusting the arrows. Please make it locked for both the
bottom of the seat and the top of the seat. It is an essential step to accommodate parameter changes.
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+ [STEP 13| Repeat [STEP 11] to [STEP 12| for the chair back and chair legs.
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[STEP 14| To define the material parameter.

= Select objects that you want to define a material.
= Click Jassociate family parameter|.

= Click [New].
= Add [000_WD_01] on Name, make sure the Group parameter under |Materials and Finishes|.

Note, the Name can be defined with elemenis (e.g., chair-legs, chair-seat).
il _
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« |STEP 15]| To add new material,

= click |[Materials] from [Manage| tab, under |Settings| panel
= add new material, rename, apply a new appearance
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[STEP 16] Adjust Family Types.

= Click |[Family Types| from [Modify] tab, under [Properties| panel.
= Update the properties

- 000_WD_01=000 WD_01

= Chair-Overall-L = 1.6"

= Chair-Overall-W=15"

= Chair-Overall-H = 2’8"

= Chair-Seat-H=1'8"

= Chair-leg-T=1 %"

= Click |OK] to finish

[STEP 17] To save a new type.

= Open [Family type]

= Click [New Type|

= Mame change [Default] to save the current settings
[STEP 18] To add a new family type.
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= Open [Family type]

= Change parameter values
= Click [New Type|

= Mame change

- Click |OK]

(CO3) Create a simple table with parameters

In this turorial, students will understand the basic knowledge of family parameters by creating a simple table family that can
change the dimensions and materials.

To create a simple table family with round, two materials

= |STEP 1] Click |File] = click [New] = click [Family| > Open |English-Imperial| folder > select [Furniture.rft] = click [Dpen].
« [STEP 2| Make [Window Tile| view to see all four views once,

+ |STEP 3| Create [Reference Planes| [RP] with |Dimensions| [D1] for overall table width, length, and height.
» |STEP 4| Define parameter.

= Table-overall-W
= Table-overall-L

= Tahle-gverall-H

= |[STEP 5] Open [Family type| window = Click [New| = Name [L4'sW2'6"xH2'6"| =Edit the value accordingly.
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« |STEP &] Add detailed reference planes and define parameters.

st g H T

= Ifthe dimension(s) need a fixed dimension like table thickness, create a reference plane and create dimension and
click the lock icon to make it unchangeable. You do not need to define a parameter.

= If the dimensionis) need an adjustable dimension like table-length and widch, create a reference plane and create
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dimension and define a parameter by adding Name.
= Once you click [Instance Parameter|, the parameter can be adjusted by dragging and dropping off an arrow.
= Adjust view scale if needed.
« [STEP 7| Click [Extrusion| = Draw the tabletop by using [Rectangle] align with the guidelines = And make all side locked
= Adjust the tabletop and tabletop thickness on the Front view. Do not forget to make it locked.
« |STEP 8| Click |[Edit Extrusion| = Draw an [Arc| for table round = make [trim| to clean the lines = check [Toggle Joint
Tangency| to lock the point.

Repeat this process to all four corners = Click |Green checkmark] to finish.
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+ [STEP 9| Select the tabletop = Click [Associate Family Parameter] by [Material] = Add [New] = Name [Table-Top| = Click
[OK| and |OK] to finish.

= |[STEP 10] Create a void corner edge by clicking [Sweep| - Click |Create] tab > Click [Void Forms| = Select [Void Sweep] =
Diraw or Pick Path ithe path should be enclosed) » Click Green checkmark to finish drawing path = Click [Modify Sweep|
tab = Click |[Edit Profile] > Draw an enclosed profile to subtract the form on the reference plan = Click Green checkmark
to finish drawing profile = Click Green checkmark again to finish the Sweep tool.

« [STEP 11] Create four cylinders for legs by clicking [Extrusion] = Click [Circle] = Click the center point of a leg = click a
point by 2" = click the circle = check [Center Mark visible] = Use align tool to lack the position > Create dimension =
Define the parameter [Leg-Radius] = Copy the circle to others and align with the guides » make the dimension for the
circle = define the parameter to [Leg-Radius| = Click [Green checkmark| to finish.
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« [STEP 12] Adjust the leg he:ght to attach to the bottom of the tabletop = lock the position.
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« |STEP 13] Select the table legs = Click [Associate Family Parameter| by [Material| » Add [Mew] = Name [Table-Legs| =
Click [OK] and [OK] to finish.

« |STEP 14| Use |SWEEP] for adding leg details. You must create the details individually with [Pick 3D Edges|. The copy
command will not work.

« [STEP 15] Add two materials and apply to the tabletop and the table legs.
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Chapter 10. Revit - Nested family

Session Objectives

Upon completing this session, students will be able to:

» (CO 1) Understand a nested Revit family and how it works
» (CO 2) Create a chair and table ser with nested Revit families
» |CO 3) Modify a door family

‘¥ Session Highlights

At the end of the session, students can create the graphics below.
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E Lecture Contents

(CO1) Understand a nested Revit family and how it works

For more information about a Family with Nested components, please read this guide on Family and Nested components from
Autodesk.

You can nestlinsert) families within other families to create new families that contain the combined family geometry.

Rather than creating a furniture family from scratch, you can create the combination-furniture family by loading legs, arms,
back supports, and more into a furniture family.

To nest families in another family, create or open a host family, and then load and insert instances of one or mare family types

into it, The host family can be a new family of an existing family.

Below example from Teknion Planning Tool.com,
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(CO2) Create a chair and table set with nested Revit families

In this tutorial, students will practice creating a simple furniture set family nested with two types of chairs and a table with
modifiable materials parameters.
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Add components in a family file

« [STEP 1] Open Revit application, Click [NEW] from [FILE| menu > Click [FAMILY] > Open [ENGLISH-IMPERIAL] >
Click [Furniture System.rfi] = Click [OPEN].

« |STEP 2] Make the view to a tile view by pressing [WT].

= [STEP 3] Save the file in your project folder by [CTRL+5],

« [STEP 4| Click [LOAD FAMILY]| from [INSERT] tab, under [LOAD FROM LIERARY] panel. Load a table and a chair
that you created from the last session

= |STEP 5] Place the table and the chair that vou created by clicking [COMPONENT] from the |[CREATE] tab, under the

[MODEL] panel. Please place it sltghtl}r off the center reference lines because we need o aiign and lock the component.
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« |STEP 6| Align and lock the components on the center reference lines.
. [STEF 7| Draw four Rgference Planes on the [REF. LEVEL] plan view.
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« |STEP 8| Align the back of all chairs to the near reference lines and make them lock.
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= |[STEP 9| Click only Horizontal dimensions and add parameter by clicking [PARAMETER PROPERTIES| > Name [DI-
HORIZONTAL| and click [INSTANCE] > click [OK].

« |STEP 10| Click only Vertical dimensions and add parameter by clicking [PARAMETER PROPERTIES| > Name [DI-
VERTICAL| and click [INSTANCE] = click [OK].
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+ |STEP 11| Load this family to a project to confirm the family works okay.

= Click |[FILE] on the menu

= Click [NEW]

- Click [PROJECT]

= Select IMPERIAL-ARCHITECTURAL TEMPLATE]
= Click |OK]
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: Click [COMPONENT] from [ARCHITECTURE] tab, under [BUILD] panel

- Click [LOAD FAMILY] from [MODIFY/PLACE COMPONENT], under [MODE| panel
= Click the chair and table set family

= Place the family on [LEVEL 1] Floor plan.

You can confirm whether the chairs are movable or not by adjusting the arrows.
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Open [EDIT TYPE] from [PROPERTIES| palette to see what properties we can edit to create other types. However, the only

property we can adjust is [DEFAULT ELEVATION]. In the next tutorial, students can edit material parameters and visible
parameters.

Add material and finish parameters

+ |STEF 1] Open [FAMILY TYPES] from [MODIFY] tab, under [PROPERTIES] panel.
« [STEP 2| Click [NEW] = Add name [TABLE-TOP], update Type of parameter to [MATERIAL].
Repeat this step for [TABELE-LEG] and [CHAIR| > Then click |OK] to finish.
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|STEF 3] Select the table = Click [EDIT TYPE| from [PROFERTIES] = Click a small box by the Table-Top = Click
[TABLE-TOP] on [ASSOCIATE FAMILY PARAMETER| > then [TABLE-TOP] will gray out.

Repeat this step for [TABLE-LEG] and [CHAIR].
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[STEP 4] Open [FAMILY TYPES] and apply materials on the parameters. You can use the existing materials or create
new materials.
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« [STEF 5| Load this updated fomily to the project by clicking [LOAD INTO PROJECT] and click [OVERRIDE THE

EXISTING VERSION|.

= |STEP 6] Select the chair and table set = click [EDIT TYPE], and vou can see what parameters are available to modify.
You can create a new type by clicking [DUPLICATE).

Add visible parameters

« |STEP 1] Select [TABLE] = Click the small box next to visible an [FPROPERTIES] to open |ASSOCIATE FAMILY
PARAMETER| > Click [NEW] > Add name [Table-H2'6"] confirm the Type of parameter is [YES/NO|, group parameter

under [VISIBILITY].

« |STEP 2| Select all |[CHAIRS] = Click the small box next ta visible on [PROPERTIES] to open |[ASSOCIATE FAMILY
PARAMETER| > Click [NEW] > Add name |Chairs-Def] confirm the Type of parameter is [YES/NO|, group parameter

under [VISIBILITY].
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« |STEP 3] Open [FAMILY TYPES] = click [NEW| type to add a new tvpe > add name |Chair and table set 1] = Click |[OK] o

finish > Click [APPLY].

« |STEP 4| Click [NEW] type again = add name [Chair and table set 2 - kids| = Click [OKE] » uncheck both |Chair-Def] and

[Table-H2'&"|.

+ [STEPS| Click [COMPONENT] > Select the table family from [PROPERTIES] > Click [EDIT TYPE] > click
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[DUPLICATE] = add name [L3'xW3'6"xH2'| = adjust dimension accordingly.

« |STEP &| Place the table and align it with the center reference planes.

+ |STEP 7] Click [COMPONENT] > Select the chair family from [PROPERTIES] = Click [EDIT TYPE] click [DUPLICATE]
= add name [KIDS] = adjust dimension accordingly.

« [STEP 8| Place the chairs and align them with the four reference £5.
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+ [STEP 9] Define the visible parameters for both the small table and the small chairs.
« [STEP 10] Confirm Family types for both set 1 and set 2-kids.
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[STEP 11] Load this family into the project and override.
« |STEP 12] Add the new type to confirm the two types are different.
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(CO3) Modify a door family

In this wrorial, stodents will practice creating a simple furnimure set family nested rwo types of chairs and a able with
modifiable materials parameters.

Edit a door family

« |STEP 1] Open the basic door file.
+ Click [FILE]
+ Click |OPEN].
= Click [FAMILY].
= Find [LIBRARIESIUS IMPERIAL\DOORS] folder.
= Click |Door-Single-Panel.rfa).
= Open.
« [STEF 2| Save the family file in your project folder.
+ Click [FILE]
- Click |[SAVE AS].
- Click [FAMILY].
= Find [vour project folder]|.
= File name [Firstname Lastname_EX3_Door-Single-FPanel.rfa).
- Click [SAVE].
« [STEP 3| Open |Ref Level], [FRONT|, and |3D0] views. Make a tile view by pressing [WT].
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« [STEP 4| Edit the door trims.
= Click the front door trim on the front view.
- Click [EDIT EXTRUSION] from [MODIFY/TRIM] tab, under [MODE| panel.
= Edit the sketches with Draw tools and use the trim tool. Make sure the edges and lines are locked.
= Click [GREEM CHECKMARE)] to finish the sketch.
= Click the backside door trim and edit with the draw tools.
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« [STEP 5] Edit Opening cut.
= Click [DPENING CUT) on the 3D view.
- Click [EDIT SKETCH] from the [MODIFY/OPENING CUT] tab, under the [MODE] panel.

= use the draw tool and the trim tool 1o edit the lines to align with the inside of the trim. Make sure the edges and
lines are locked.
= Click |GREEN CHECKMARE] to finish the sketch.
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« [STEP 8| Edit Door.

= Click the [DOOR] on the 3D view.
- Click [EDIT EXTRUSION]| from [MODIFY/PANEL| tab, under [MODE] panel.
= use the draw tool and the trim tool 1o edit the lines to align with the inside of the trim. Make sure the edges and
lines are locked.
= Click |GREEN CHECKMARE] to finish the sketch.
« [STEP 7] Add door window on the door panel.

= Add a reference plane for the door window height.

= Add a dimension from the floor level and add a parameter.

= Create a void extrusion with the drawing tool, check [CENTER MARK VISIBLE], and align with the center line and
the Door Window H reference plane.

o i e i iy s e 7R

= Adjust a void extrusion height on the Ref. Level and lock the end and start points,

= Click |[CUT] from the [MODIFY] tab, click the void and then click the door panel to cut the void.
= Add a window trim with [SWEEP] from [CREATE] tab, under |FORMS] panel.

= Add material for the window trim.

= Add a window with [EXTRUSION] from [CREATE] tab, under |[FORMS] panel.

= Add material for the window.
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+ [STEP 8| Update [VISIBILITY/GRAFHICS OVERRIDE].

= Select the door window trim and the window.
= Click [EDIT] on [VISIBILITY/GRAPHICS OVERRIDE].
= Uncheck |PLAN/RCF| and [WHEN CUT IN PLAN/RCP|.
+ Click [OK].
« |STEP 9| Test the family in a Project and edit the parameters that you added.
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Chapter 11. Revit - Organic shaped walls

Session Objectives

Upon completing this session, students will be able to:

» (CO 1) Create a slanted wall without Massing toals

{CO 2) Understand various 3D models using Massing
» {CO 3) Create an organic shape wall

(CO 4} Create an organic shape curtainwall

¥ session Highlights

At the end of the session, students will be able to create the graphics below.

E Lecture Contents

(CO1) Create a slanted wall without Massing tools

A slanted wall is a new feature of Revit 2021,

Once you create a wall using [wall| from the [Architecture] tab, under the |Build| panel, vou have an option to make the wall a
slanted wall.

« [STEP 1] Select a wall(s) that vou want to make a slanted wallis) on a floor plan or a 3D view.
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[STEP 2] Update the setting [Cross Section] for the wall from [Properties| palette to [Slanted].

[STEP 3] Update |[Angle From Vertical| to the desired degree.

[STEF 4] If you have dimensions or reference planes, you will receive an error message. Click [Remove reference| orfand
[Delete Dimensions|.
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[STEP 5] To make all windows aligned with the slanted wall, select all window instances. Update the setting [Orientation|

for the windows from [Properties| palette to |Slanted].
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(CO2) Understand various 3D models using Massing

Massing/ Massing studies is a useful tool to explore design ideas by shapes to conceptualize a building model. When the
conceprual design is complete, you can add building elements directly to the shapes.

Create in-place or family-based mass instances that are specific to individual design options.

Generate floors, roofs, curtain systems, and walls from mass instances with control over element category, type, and parameter

values. Fully control the regeneration of these elements when the mass changes.

For more information regarding massing in Revit, please refer to this Massing Studies tutorial.

To create a simple mass with other masses

« |STEP 1] Open a new project or use the existing Revit project.

« |STEP 2| Click |Show Mass by View Setting| from |[Massing & Site| tab, under [Conceptual Mass| panel, this command is
to see mass. [f you want to hide mass, click again [Show Mass Form and Floors).

« |STEP 3| Click |In-Place Mass| from |Massing & Site], under |Conceptual Mass| panel > Name the mass.

« |STEP 4] Click |Set| from the [Create] tab, under the [Work Plane| panel to set a work plane, in this case, select |Level 1).

« [STEP 5] Click [Model] from [Create| tab, under [Draw| panel = Draw [Rectangle].

+ |STEP g| Select the rectangle = Click [Create Form| = Click [Solid Form|.

« |STEP 7] Now you can control the mass by the face, edge, and point.

« [STEP 8| If needed, you and add mass with |Join| tool, subtract mass with [cut] or void form.
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« [STEP 9| Once the mass seems in the right form, click [Finish Mass].
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To create mass Floors

= [STEP 1] Select the mass you want to make floors.
« [STEP 2| Click [Mass Floors| from [Modify/Mass| tab, under [Model] panel.

« |STEP 3| Check levels for the floors.
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To create an architectural model (Curtain Wall, Wall, Floor, and Roof) by face

« |STEP 1] Use |Curtain System, Roof, Wall, Floor] from [Massing & Site] tab, under [Model by Face| panel.
« |STEP 2| Click a face 1o create architectural models.
« |STEP 3] Click [Create system, Create floor, Create roof] from [Modify/Place| under, [Multiple Selection] panel.

. e T———
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To modify the mass and update architectural models
= [STEP 1] Click the mass » Click [Edit In-Place].
« [STEP 2] Modify the mass by controlling the point, edge, and face = Click [Finish Mass].
« |STEP 3| Click model|s) > Click [Update to Face] from [Modify] tab, under |Model by Face].
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(CO3) Create an organic shape wall

In this ttorial, you will create an organic shape of the wall using Massing in Revit. To create an organic-shaped wall, you will

need profiles (lines) on reference planes. By connecting the profiles, an organic-shaped wall will be created.

[STEP 1] Draw more than two reference planes on a floor plan [Level 1]. [ will create three reference planes. Click |Ref
Plane| from |Architecture] tab, under [Waork Plane] = Add dimensions if needed » Define names for the reference planes
(Wall-1-L, Wall-1-C, Wall-1-R}.
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« |STEP 2| Click |Show Mass by View Setting] from [Massing & Site| tab, under [Conceptual Mass| panel, this command is
to see mass, if vou want to hide mass, click again [Show Mass Form and Floors],

« |STEP 3] Click |In-Place Mass| from |Massing & Site], under |Conceptual Mass| panel = Name the mass [Organic Wall-1].

» |STEP 4| Open [East| view and [3D] view, and make a tile view [WT].

« [STEP 5] Click |Set] and click [Show| from [Create| tab, under [Work Plane| panel, Select |[Reference Plane: Wall-1-R| from
the option bar.

= |STEP a] Click [Model] from [Create| tab, under [Draw]| panel = Draw a line with [Spline through point] = Draw a line on
the 30 and modify the line on the East view.
Repeat this step for the three reference planes.
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« |STEP 7| Select all profiles on [3D view| = Click |Create Form = Salid Form| from [Modify] tab, under [Form| panel.
Change display mode to shaded an 3D view.
. fSTEF' 8] To modify the shape of the wall, click the wall = Click [X-Ray] = vou can edit the point, edge, and face.
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+ |STEP 9| To change the profiles, click |[Edit Profile| = edit profile = Click [Green checkmark] to complete this command.
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« |STEP 10] To complete the mass, click |Finish Mass),
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« |STEP 11] To add a wall, click jwall| from [Massing & Site|, under [Model by Face| panel > Select a wall type = click the

face of the mass to create a wall.
Mote. If vour wall is too thick or the mass is too wavy, vou will get an error message.

(CO4) Create an organic shape curtainwall

[n this tutorial, you will practice an organic-shaped curtain wall.
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+ [STEP 1] Click [Component] = click [Model-in-place| = Select |Mass] from [Family Category and Parameters| = click [OK] =
Define name |Organic curtainwall-1].
Mote. This method is the same as just creating a mass from [Massing & Site].

« [STEP 2| Click [Model] and draw a curve line with [Spline Through Point] on Level 1. Make sure [Placement Plane] is
[Level: Level 1.

« |STEP 3] Open Level 2 floor plan = Click [Model] and draw a curve line with [Spline Through Point| on Level 2. Make sure
[Placement Plane] is [Level: Level 1),

« |STEP 4] Select all profiles on [3D view| = Click |Create Form = Salid Form| from [Modify] tab, under [Form| panel.
Change display mode to shaded on 30 view.

« [STEP 5] Click [Finish Mass] to finish the model.
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« |STEP g Chck |Curtain System| from [Massing & Site| tab, under [Model by Face| panel = Click the mass vou created =
Click |Create System| from [Modify] tab, under [Multiple Selection].

194 | Chapter 11. Revit - Organic shaped walls



G| g xR 8 Bt
] creeten

EE;:I'?I?}'HE?F%_

U e A m s BT
Bt &

i S o S R T e [ ] i prane MEFG B SGAN QS mATE = r o —

—p——

[STEP 7] Click the curtain system > change the size of the panels by adding a new type [2x Z'].

E—— ]

[STEP &) You can add and remove the grids by clicking.
[STEF 9] Add Mullion by clicking [Mullion] from [Architecture| tab, under [Modify] panel. You also may add a mullion
type to fit the size of the panels.
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Chapter 12. Revit - Organic shaped ceiling and
column

Upon completing this session, students will be able to:

» |CO 1) Create an organic wooden pattern ceilingfwall/bench
+ (CO 2) Create a geometric pattern ceiling
» |CO 3) Create an organic column vs. a geometric pattern column

¥ session Highlights

At the end of the session, students can create the graphics below.
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E Lecture Contents

(CO1) Create an organic wooden pattern ceiling/wall/bench

In this tutorial, you will use massing to create an organic pattern form for the ceiling, wall, and bench. You will use create solid

form and void form to create wooden panels.

+ |STEP 1] Create Floor, wall, and ceiling to define the boundary of the space = Open a floor plan, a side view, and 3D view

with section box to see the wall view > make a tile view = change visual style to |floor plan - hidden line|, [side view -

'.-. ireframe|, [3D view - shaded with edge|.

-Fm-ll-_l—__“r_i-h—-“rh

IIIIJ‘I'llr T L:'r-'bﬂi_i; B oS Al

H-l-n—na—-- — Bt iy B Sy Reiny Bemy b e i

— ™

aretw OB C R NN S )

v - e apr OO o BTl e
L 1 e " b et (TR i BT

. o MBS GGAaEN > Ml ¥ #
& s 1 TSRS

« [STEP 2| Set reference planes with dimensions and names.
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[STEF 3] Create a mass with [In-Place mass] by drawing 5 model lines (use spline and lines).
Tips. Create a closed-loop with splings and lines and create a form o confirm the loop can be created the mass. Copy the loop on
the same reference plane and change the host so others and edit the line shape.
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[STEP 4] Create solid forms. You must select only two and make a solid form. So, you need four forms if you have five
closed loops = Select forms and apply a material.
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« [STEP 5] Create a rectangle void form and copy = Click [Finish Mass] to complete the modeling.
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(CO2) Create a geometric pattern ceiling

In this tutorial, you will use massing to create a geomatic pattern form for the ceiling. You will use nodes and components to
create geometric surfaces.
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« [STEP 1] Create Floor, wall, and ceiling to define the boundary of the space = Open a ceiling plan, a side view, and 3D
view with section box to see wall view > make a tile view > change visual style to [ceiling plan - hidden line|, [side view -
wireframe|, [3D view - shaded with edges|.

« [STEP 2| Set reference planes with dimensions and name them. I will create two reference planes for different

dimensions.
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= |STEP 3] Add nodes on the different levels of reference planes.
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= |STEP 4] Insert a family [Triangle (bent| Surface] from Revit library [Curtain Panel By Pattern].
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[STEP 5] Add the component by selecting nodes,

G MELRe= soeod-Ngmn P on s RIS @ v X
= SISy R - Rt s lB Dl S
ol (e Bk ey -y m— e
Sor et | SIS O = - -
o . e e L e e et W
PE Hee
a Lo |
- bt

wf;l*- . e - - ' ..
"—"'_’k S — 4 ==

L]
—
n —
=
: el
Y
- ] P
] P
=t
e pd O il sl s = & {
e L Ll
[t
& y
+-.
[
. L}
.
. |
R | e ORI 2 ] B e B G STER - v - o E——

+ [STEP 6] Add/Modifv material if needed.

202 | Chapter 12 Bevit - ﬂrgn.nlc :l'luped ceiling and column



s
-

co—

- —

————

L=

e

o »
.

= H
h-.. —

oy ——

L] L d
-— £ '
Lo s

i SIS TR
»

.
o NN e OpasTEE ] w e BN G STEE &l e n

[STEF 7] Select |[Finish mass| to complete creating the mass. To change shapes or material, you must click the mass
instead of the family, then you click |Edit In-Place].
Hute Yuu can add Ilghnug ﬁ::l:u:es by s-electlng [Flace on Face|.
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(CO3) Create organic column vs. geometric pattern column

In this mtorial, vou will use massing to create an organic pattern form for a column and a geometric form for a column, You
will use technics that you used in CO 1 and CO 2.

+ |STEP 1] Set reference planes with dimensions and names.
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+ |STEP 2| Draw model lines on referent planes.
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« |STEP 3| Select model lines that you draw and create a solid form.
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[STEP 4] Click |Divide surface| > Adjust numbers of U grid and V grid » Select a pattern that you want to use, but this
function may not be useful to apply materials and be accurate modeling.
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[STEP 5| Copy the mass and click [Dissclve| from the [Modify| tab. Add components by clicking the points of the model
lines to create geometric faces.
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Chapter 13. Revit - Sketchup models

Session Objectives

Upon completing this session, students will be able to:

» (CO 1) Create an advanced Revit Site model (Surroundings)
» |CO 2) Import Sketchup models into a Revit project with material changes
» (CO 3) Import Sketchup models into a Revit project without the complex lines using 3Ds Max

‘¥ Session Highlights

At the end of the session, students will be able to create the graphics below.
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E Lecture Contents

(CO1) Create an advanced Revit Site model (Surroundings)

Examples of how I create architectural surroundings/backgrounds

[METHOD 1] For a rendered scene.

= [STEP 1] I usually create a site model in a smaller boundary like just the next buildings and a few trees.
+ [STEP 2| Then set perspective views that have similar angles with site photographs.
+ |STEP 3| After the final render of the perspective views, photoshop the views with the photographs.

! image credit: Bee Breeders
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[METHOD 2| For an animation a VR, and a panorama view.

« |[STEP 1] I build a detailed site model including topo, road, trees, other buildings in Revit.
+ [STEP 2| After the final render of the perspective views, photoshop the views with the photographs.

-

I
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Various site modeling techniques in Revit

In Revit

+ [STEP 1] Create [toposurface] using CADMAFPFER model (dxf). Please refer to the video link.

+ |STEP 2| If vou need detailed surrounding buildings, you must build the model by using massing (apply a material) or a
wall and roof. If you don't need detailed surrounding buildings, you can use the model from CADMAFPPER. You can add
material on [Object Styles| from the [Manage| tab. You can find the CAD layers from the [Imported Objects] tab in
[Object Styles).

= [STEP 3] Draw Building Pad for your building area to make the site flat. If your site needs, vou need to add/adjust the
[toposurface].

+ |STEP 4] Add |Property Line| if you know.

= |STEP 5] Use |Split Surface] to crop the [toposurface] andfor add different materials on the surfaces.

+ [STEP 6| Use [Subregion| to divide the surface, usually, this tool is used for roads.

+ |STEP 7| Use |Site Component| to add trees and other street elements. But [ prefer to use |Component| from [Enscape

library|.
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In Sketchup

iBased on the author's practice experience, many firms are still using Sketchup for their design including site model, building

models)

[OPT 1| Geolocation (Accurate GIS information, but not detailed modell.

« |STEP 1] Open Skechup application = Click |Add Location] = Add |Address| =Zoom in or out for a desire size of map.
« [STEP 2| Click [Region] = Change the four corners of the rectangle = Click [Import].
« |STEP 3| Open |Laver| panel = hide [Location snapshot] layer and show |Location Terrain].
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[OPT 2| Use the 3D model from CADMAPPER (only a certain size of the map is free).

« Visit [Cadmapper] = Sign in = Enter |Address] and find the site » Download in |Sketchup| format = Open the model (Make
sure this model is in Metric system).

[OPT 3| Use the SANDBOX tool (Need GIS information for the modeling, but you can create a detailed model).

(CO2) Import Sketchup models in Revit project with material changes

Although moany manufacturers provide Revit Family and Revit also provides numerous libraries, designers always seek new
models and objects for their design and renderings. Sketchup 3D Warehouse provides a great library for designers and

manufacturers. [ added three Video tutorials to import the Sketchup model to Revit Family for your reference. You may trv.

+ Skerchup Model to Revit. Please, watch this mutorial video for importing SketchUp files into Revit.

+ Sketchup Model to Revit - Material changes. Please, watch this tutorial video for converting SketchUp models into Revit

fwith Materials).
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Sketchup model to Revit with updating material changes

= [STEP 1] Sketchup Model to DXF file.

= Open the Sketchup model in Skerchup, or download a furniture model from a 30 warehouse, In this process, you

may need Sketchup Pro.

= Create layers by material. If you have 3 materials, create 3 layers with unigue names (e.g. W) _Chair_sk_seat_01,

000_Chair_sk_leg_01, 000_Chair_sk_base_01).
: Explnde all mudels unn] nothing is to be exploded.
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= Change layer in [Entity Info] Tray by selecting the layers that you made.
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= Do the same procedure (material selection and layer change) for other materials.
= Export = 3D model > Select DXF file = Click option > Select only Faces = Version 2007> OK > Export.
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Maodeling credit: Vofislav N. downloaded from 3D warehouse
= [STEP 2] DXF file Properties change.

= Open AutoCAD.

= Open the DXF file in AutoCAD. It will show in a 3D view.
= Select all lines by pressing [Ctrl+A].

= Change Object color from [Home] tab = Color |By Layer],
= Save the DXF file with Version 2007.
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+ |STEP 3| Import DWF file (Furniture) to Revit.

File » New = Family = Select Family Template file (Furniture).

[nsert tab > Import CAD = Change files of type to DXF = Select the file » Click [Open| = Save the family file = Load

i =

into Project.
= i -

+ |STEP 4] Change materials for an imported file in the Revit project file.

Manage tab » Object Style.
Click Imported objects.

Change material by clicking the material slot.
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(CO3) Import Sketchup models in Revit project without the complex lines
using 3Ds Max

This lecture contents from this video tutorial on importing from 308 max to Revit. Complex 3D max Model to Revit - Hide
the complex model lines in Revit (Super advanced level).

Sketchup model to Revit without the complex model lines

« |STEP 1] and |STEP 2] are the same as CO2,

« |STEP 3| Open |3Ds MAX] application.

+ [STEP 4| Click [File] = Click [Import] = Click [Import] = Select the [DXF] file = Click [Open] = Click [OK] on [AutoCAD
DWG/DXF Import Options|.
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[STEP 5] Click |Default Shading| on the view = Select [Edged Faces],

e X Y EE s o e W L o - AR src FOEAT R aE-wll

= |STEP 6] Select all by pressing [Ctrl+A] = Click [Modify] tab > Select [ProCptimization] = Check [Merge vertices] = Click
[Calculate| = Adjust [Oprimization Level).

Chapter 13. Revit - Sketchup models | 215



AT e Ew=ell

[STEP 7] Select |[Edit Mesh] from [Modifier List] = Select [Edge| > Select [Invisible].
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+ [STEP 8 Save the DXF file.
« |STEP 9| Import DWF file (Furniture| to Revit.
= File » New = Family = Select Family Template file (Furniture).
= [nsert tab = Import CAD = Change files of type to DXF = Select the file = Click [Open| = Save the family file = Load

into Project.
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|STEFP 10] Change materials for an imported file in the Revit project file.

= Manage tab = Object Style.
= Click Imported objects.
= Change material by clicking the material slot.
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Compare a family file without edges (left) and a family file with edges (right.
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Chapter 14. Sketchup advanced modeling

Session Objectives

Upon completing this session, students will be able to:

» (CO 1) Understand the process of a Revit model to a Sketchup model for rendering
» (CO 2) Understand the Skerchup modeling process and strategies
» |CO 3) Understand Sketchup advanced modeling with plug-ins

‘¥ Session Highlights

At the end of the session, students will be able to create the graphics below.
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E Lecture Contents

(CO1) Understand the process of a Revit model to a Sketchup model for
rendering

Many firms use Revit and Sketchup together for various purposes. As you know, Revit is an excellent application for
Construction Document sets, but the application is complicated at the beginning of the design process, especially Schematic
Design(SD). Thus designers use SketchUp or Rhino for SD and Design Developments. Also, designers often use Sketchup for
renderings.

You have learned how to import a Sketchup model into a Revit model from the previous lecture. In this tutorial, you will learn
how to use a Revit model in a Sketchup. Furthermore, understand how we can apply materials in Sketchup.

Students can use your project, including this course project and yvour previous studio project. If you want to use the Eames

House model (Revit version 2021}, which the instructor will demonstrate, feel free to download the model from the Canvas
Module under EX3.
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Prepare Revit model for Sketchup model

« [STEP 1] Open a 3D view. | recommend opening an [80 view, using the [Section box| tool to crop unnecessary items.
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|STEF 2] Hide elements (levels, section box, trees, and Enscape models) that are not needed for the Sketchup model.
For the best results, 1 also recommend hiding furniture, special equipment, plumbing fixture, and millworks.

[f vou need to show only a category, ex) furniture category, use [Isolate category.
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[STEP 3] Confirm you open only the view that vou want to export.
Click |File| » Click [Export] = Click [CAD formats| = Click [DWG].
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« [STEP 4] Click |[Setup] icon to open Modify DWG/DXF Export Setup = Select [Solids| tab = Click [ACIS solids| = Click
[OK]| = Click [Mext].
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« [STEF 5| Select |AutoCAD 2007 DWG files| for the files of type, and uncheck |Export views on sheets and links as
external references = Click |OK|.
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Import a DWG file in the Sketchup model

= |[STEP 1] Open the [Sketchup| application.

+ [STEP 2| Click [File] = Click [Import].

« |STEP 3| Once the [Import| window is open, find the folder that you saved the DWG file, and select the file = Click
[Options...] > Confirm the unit and [Preserve drawing origin| is checked = Click [OK] = Click [Impeort].
It will take some time to import the DWG model. The time depends on the complexity of the model. If you import a
model, including furniture, it will take more time. For best practice, you need to export the furniture separately or add
furniture from the 3D warehouse.
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« [STEF 5| Open |Lavers| or [Tags| tray to see the structure of the model.
You can clean up the model by checking the visible on Layers = Purge layer after cleaning up.
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+ [STEP 6] Adjust [Soften Edges| value to hide the triangle edges.
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Apply materials

You can apply materials by selecting objects. To select objects, you can turn on and off layers.

« [STEP 1] Remove all existing materials from Materials,
+ |STEP 2| And select a material from the library.
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+ [STEP 3] Apply the material to the elements.
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« |STEP 4] Repeat this process for all materials.
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(CO2) Understand the Sketchup modeling process and strategies

Many senior students know how to create Sketchup models. However, here are some tips to help speed up vour modeling.
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[TIP 1] Please use Keyboard Shortouts.

=« Spacebar - Select tool.
« R - Rectangle tool.
+ L-Line tool.

« M - Move tool.

+ P - Push/pull tool.
+ 5 -Scale tool.

« ) - Rotate tool

« E - Eraser tool.

+ G- Group tool.

= B - Paint toal.

« K - Back Edge.

[TIP 2] Define - Custom Keyhoard Shortcuts.
If you need a shortcut, you can define keyboard shortcuts.

+ Click [Window] = Click |[Preferences] = Click [Shortcuts
B e B ok [ —
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« [fyouwant to save the shortcuts for your future use, click [Export]. And [Import| the shortcuts to load the shortcuts.
«  Use |Shift] Key to hold axes.

[TIP 3] Move objects along Axes.
Moving an object is not easy for a beginner. Try to move objects along Axes.

+ Use the direction keys (Up-Blue axes, Right-Red axes, Left-Green axes) to lock Axes while you move objects.
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+ You can also define Axes by clicking [Tools| > click [Axes|.

[TIP 4] Use inferencing to place abjects.

«  Use other objects to move and rotate objects.
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|TIP 5] Model using groups and components (any objects that will be used multiple times in the model).

= Ifyou do not make a group/ a component of an object, faces will merge and be difficult to contral.
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[TIP 6] Use layers/tags.

+ Layers/tags are applied in an object/ a group/ a component.

+ [LayerD] is a default and a base layer for an object.

+ Once you create a group or a component, assign a layer/ a tag.
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[TIP 7] Create multiple copies with the Move tool or the Rotate toal.

« Use [x] to multiple.
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[TIP 8] Create Equally spaced copies.

« Use |/] to divide.
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[TIF 9] Use [Solid Tool| to create a unique shape of an object.

« Use union, intersect, subtract, trim, split.

e e Les e e e Rl

[TIF 10| Set Field of view - 72 deg ~ 30 deg by press [z].
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(CO3) Understand Sketchup advanced modeling with plug-ins

Extension warehouse

The Extension Warehouse is an online resource full of plug-ins developed especially for SketchUp. These extensions enable
you to add special tools and features to SketchUp,
Refer to this linked page.
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SketchUcation

SketchUcation is a growing community and resource center for SketchUp Users. There are more than 800 SketchUp
Extensions in this linked community.
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Extension manager

You can install new extensions and manage installed extensions.
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Fre

e extensions — Recommended installing

BZ Tool - Draws a variery of Polylines, Bezier and Spline curves, all in 3D,

lointPushandpull - Perform various extrusions of faces.

Curviloft - Dedicated to Loft and Skinning, that is, generation of surfaces from contours.

RoundCorner - Performs the rounding of the edges and corners of 3D shapes along a 2D profile, in 3 modes: Round
corners, Sharp corners and Bevel,

Sketchy FFD -

Adds a control cage to an object that allows the mesh to be manipulated via control points.

ThruPaint - FredoTools groups a number of my standalone plugins. By delivering them as a single package.

SectionCutFace - Adds faces to a Section-Plane.

Paid extensions for subdivided and smooth model

SubD - SUBD is a parametric subdivision extension for SketchUp optimised for quad-based workflows.

CuadFace Toaols - Suite of tools for working with non-planar guads in SketchUp. Enables logical quad-based topology to
be created - which in turn permits the use of ring and loop selections seen in other 30 modelling software.

Vertex Tools - Take control over each vertex with this vertex editor for SketchUp. Soft selections are a must for organic
modelling and the manipulator gizmo gives you great control when modelling.

Artisan - Artisan is a SketchUp extension filled with powerful organic modeling tools.
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Additional paid extensions for Architects

= For more information regarding paid extensions, please watch this linked video.
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PART FOUR. ADVANCED RENDERING

Chapter 15. Vray for Sketchup

+ Beintroduced to VRAY

« Understand Vray render and camera settings
«  Understand Vray material settings

«  Understand Vray lighting sertings

« Understand the Final render and save the image

Chapter 16. Lumion - User interface & import 3D model

« Be introduced to Various Rendering software
+ Install Lumion Pro Student

+ Understand the interface

+ Import a 3D model

Chapter 17. Lumion - surroundings, objects, & materials

«  Add surroundings
«  Addjedit materials
»  Add objects

Chapter 18. Lumion - Lightings, scenes, & outputs

«  Addfedit lighting
«  Add/edit scenes
+ Render outputs

Chapter 19. Photoshop — brushes and guick retouch

«  Be aware of various tips and skills for better interior perspective renderings
+ Beintroduced to various sites for texture, cutouts, and more for references
» Be able to produce a rendering with a quick retouch
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Chapter 20. Photoshop - Advanced rendering post-production

+ Understand photoshop brushes and Wacom tablet

«  Understand post-production for exterior perspective rendering
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Chapter 15. Vray for Sketchup

Session Objectives

Upon completing this session, students will be able to:

» (CO 1} Be introduced to VRAY

» (CO 2) Understand Vray render and camera settings

» |CO 3) Understand Vray material settings

» (CO 4) Understand Vray lighting settings

» |CO 5) Understand the Final render and save the image

¥ session Highlights

At the end of the session, students will be able to create the graphics below.

Chapter 15. Vray for Sketchup | 235



E Lecture Contents

(CO1) Be introduced to VRAY

V-RAY is a computer-generated render plug-in for 3D computer graphics software (3Ds Max, Revit, Rhinoceros, SketchUp,

& more). This application is used for video game production, industrial design, product design, architecture, and the interior
design industry.

Chaos Group developed V-RAY in 1997. This rendering engine uses Global llumination algorithms, including path tracing,

photon mapping, irradiance maps, and directly computed global illumination.

Watch these Quick Start Tutorials from ChaosTV.

For additional resources, please refer to the V-Ray for SketchUp Courseware site,

Image credit Chaosdocs

-3 V-Ray tor SketchUp Courseware
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Rendering Examples

V-RAY trial installation for one month

You may be able to download and use the trial version for one month after you purchase the trial version via the Chaosgroup

wehsite.

« |STEP 01] Go to Chaosgroup website
= |STEP 02] Sign up Chacsgroup if you don't have an account, then Log in to the website

« |STEFP 03] Click TRY on the top right corner of the screen

+ |STEP 04| Click Download V-Ray for SketchUp trial

= |STEP 05] Select and download V-Ray for your appropriate SketchUp version
« [STEF 0&] Open Sketchup and Confirm Extensions

Watch this video guide: How to Download and Install V-Ray for Sketchup Pro - Easy, Quick, Free Trial Version by jbdtube.

(CO2) Understand Vray render and camera settings

Before you start to render using V-Ray, please watch this video to learn how to ready vour SkerchUp model.

To learn more about the key steps, please watch this video as well: The Kev Steps to Rendering Interiors with V-Ray for

Skewchlip
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V-RAY interface in SketchUp

For more information about the interface - refer to this V-Rav Sketchup Interface puide

« Toolbar
OO FE TONDO OB % |03

This toolbar includes the most commonly used tool for users. There are three {loating toolbars in version 3.

= V-Ray for SketchUp - Asset Editor, Render button, Realtime render button, Batch Render, Show Frame Buffers, lock
the scene for real-time render
= V-Ray Lights

= V-Ray objects

«  Asset Editor
& V-Ray Asset Editor - oIl

settings in this window

= You can deal with materials, lightings, objects, and render settings. Also, you can start to render and open frame
buffers to see the results.
To open the material library, click a small arrow on the left side of the material Asset Editor.
To open advance edit mode, click a small arrow on the right side of the Asset Editor.
+ Frame buffer
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& v-fay frame buffer - |100% of 800 x 450]

RGE color - (i

Frame Buffer window allows you to see the render process and result and save the render results in different image
formats, such as JPG, PNG, TIFF, and more. Additionally, you can adjust the rendered image with various tools, like

exposure level, white balance, hue/saturation, levels, and curve.

Render setting for a REALTIME V-RAY RENDER - a preview mode

How do we prepare your SketchUp model for a V-RAY rendering? It depends on your process of work. For example, if you
directly build all of the models in the SketchUp file and apply the materials while modeling, vou can use the V-RAY at any
time, even at the beginning of the modeling. Using a completed Revit model for better rendering results, you can use V-RAY
after building all of the models and then applying materials and lighting through V-RAY. This tutorial will demonstrate how
you create a rendering based on the Eames House 30 model from the Revit model. | only added SketchUp Glass on the model.
In the previous lecture, I showed how to import the Revit model to the SketchUp model and apply the SketchUp material.

Please refer to the previous lecture for the information.

Download this file for your practice: ¥ray Lecture-Eames house-01A-Lecture readv.skp

« |STEP 01] Be ready for your SketchUp model for a rendering. You need to complete the 3D model in detail. The model

can be completed from Revit ar directly from SketchUp.
« [STEP 02] Set your camera view to render. It is always wise to set the camera view, a scene, first before rendering.
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= To set the view, you can use |Position Camera|, [Look around|, and jwalk| tools for the proper position of the view.

= Use the [Zoom| tool to set the right camera angle (typically, 50 degrees to 90 degrees, | prefer 72 degrees).

You can use the [Two-point perspective] tool under the [Camera] menu to create the right camera angle. Most
professional renders use a 2-point perspective for the final render to make all vertical lines straight up.

Use |Add scene| under [View| = |Animation| to save the view. You can rename the scene by opening [Scene manager),

= Make sure your sun/shadow setting is what you want for the rendering.

« |STEP 03] Realtime render for a preview.

= Open |Asset Editor| from the toolbar.
= Click |Settings] on the [Asset Editor].

= Click [Render with V-RAY interactive), the icon with hand to start a real-time render.

* Make sure [Interactive] under Render is on.
= Click |Lock Camera Orientation| on the toolbar.
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«  Try to modify the render settings,

= Check [Safe Frame| is on.

= Exposure Value (EV) to be 14. It is for exterior or bright interior space. If it is a night view or dark interior space, use
5,

= Adjust White Balance - if you want the warm color of the image, add blue-ish color.

= Adjust Vignetting - 0.3 - not to make too much of this effect.

= Render Cutput to 600X338 to save the preview render time.

= Addfadjust |Aerial Perspective| for a more realistic image.

= Add [GI] and |Reflection] under Environment.

= Add [Ambient Occlusion] to darken the overlapped edges, which makes more volumetric rendering.
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(CO3) Understand Vray material settings

V-Ray provides many advanced settings for realistic and artistic renderings. There are at least three ways to apply V-Ray

material.

Tip 1. Material name praoperly. For example, 001-GL-EX-01, 001-CPT-RED-01, or 002-WD-DARK-FUR-01

For more information, refer to this Materials in V-Ray tutorial.

[METHOD 1] Use a SketchUp material and update V-Ray material properties

This way is helpful if you know how to add/edit the material properties. Suppose your SketchUp model already has the

SketchUp materials that you want to use for your project. In that case, vou can update the material in Asset Editor by editing

Reflection, Refraction, Bump, Displacement, and more.

[STEP 01] Click the [Paint Bucket] tool, shorteut [b] on the keyboard, hold the [ALT| key on the keyboard, and select the
SketchUp material that you want to update.
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[STEP 02] Click [V-Ray Asset Editor] on V-Ray Toolbar, and confirm that the material that vou selected is activated. Click
the small arrow button on the right side of the Asset Editor to open the advance editor. It is optional to activate the
interactive render how it changed.

[STEP 03] Now you can edit the VrayBRDF for Diffuse (bitmap image), reflection (Black-0% reflection, White-100%
reflection), Reflection Glossiness (1-clear reflection, O-diffused reflection), Reflection (Black-0% transparency,

Whire-100% transparency), and [OR (find more information in this Metal Shaders toriall.

Additionally, you can edit the Map for Bump texture- add images ithe same image, it would becter result in a Black and

White image) or Displacement texture (more advance - longer render time).

« [STEF 04 If vou want to change the image scale on the SkerchUp materials panel. You also can change the preview mode
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from generic to floor, wall, fabric, or Ground.
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[METHOD 2] Select an object with a SketchUp material and replace it with a V-Ray material
from the library

This method is helpful if you don't have any knowledge to edit the material properties. You can use this method if your
SketchUp model has a material already applied and you want to reply with V-Ray material from the library.

« |STEP 01| Click the [Paint Bucket| taol, shortcut |b] on the keyboard, hold the [ALT| key on the keyboard, and select the
SketchUp material that you want to update.
« [STEP 02] Select V-Ray material

= Click [V-Ray Asset Editor] on V-Ray Toolbar

= Click the small arrow on the left side of the panel to open the V-Ray material library

= Click one of the categories to see the material. You can search for material from the library

= Select one material from the library, drag and drop the V-Ray material to the Material List on the Asset Editor
= Rename the V-Ray material by mouse-right click

= Adjust the material properties if you want - diffuse, reflection, bump, and more
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= |STEP 03] Replace the old SketchUp material with the new V-Ray material

= Mouse right-click on the old SketchUp material and select |Select Objects In Scene|
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= Muouse right-click on the new V-Ray material and select [Apply Material To Selection|
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= Adjust the material properties (size of texture, color, reflection, bump, and more| with the interactive render if

needed.
= |Optional] You may remove the old SketchUp material to clean up vour material selections.

[METHOD 3] Start from scratch

If vour SketchUp model does not have SketchUp material to start, you can use this method.

« |STEP 01] Select V-Ray material

Click [V-Ray Asset Editor] on V-Ray Toolbar

Click the small arrow on the left side of the panel to open the V-Ray material library

Click one of the categories to see the material. You can search for material from the library

Select one material from the library, drag and drop the V-Ray material to the Material List on the Asset Editor
Rename the V-Ray material by mouse-right click

Adjust the material properties if vou want - diffuse, reflection, bump, and more
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= |[STEP 02| Close |[V-Ray Asset Editor|
« [STEP 03] Apply the V-Ray material using the [Faint Bucker| tool. Even though vou apply a material using Paint Bucket,
the material contains V-Ray material properties.

You may use layers/tags for selecting the material thar you apply the selected materials
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(CO4) Understand Vray lighting settings

Ser sun and sky

Before we work on artificial lightings, understanding sun orientation and adjusting the sky is necessary. V-Ray recognizes
SketchUp Sun orientation. To see the current building orientation and sun relation setting, open the [Shadow Setting| panel
and check [Show/hide Shadow]| to see the direction of the sun is suitable for vour rendering. If you want to change the sun's
direction, you may change the building orientation, time zoon, time, and date.
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In Asset Editor, you can control the Sun settings. For example, you can change the Sky model, change the color of the sky, the
intensity of the sun, the density of ozone, and more.
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Self-illuminated materials — Lighting source

To express self-illuminated material like a lighting source or lighting shade, you can add [Emissive] on a V-Ray material.

= |STEP 01] Click [V-Ray Asset Editor], click |Add material] on the left bottom of the panel, click [Emissive] on the menu,

change the material name,
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« [STEP 02] Adjust the |[Emissive] properties (Color, Intensity, Transparency, and more|
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« [STEP 03] Apply the emissive material to the object using the [Paint Bucket| tool on SketchUp.
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Add V-Ray lighting source — Rectangular for windows

This tip is a trick of V-Ray rendering. Adjusting the intensity of the Sun on V-Ray is not enough to illuminate the interior
space. V-Ray users add Rectangular lighting sources on windows to make the space brighter and better render results. This

may minimize the noise effects on the render results.

« [STEP 01) Click [Plane Light] on the V-Ray toolbar, draw the recrangular shape on a window. You may not perfectly fit
the plane to a window. A slightly smaller size of plane light works better.
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« [STEP 02) Open [V-Ray Asser Editor], Click the [Lights| on the top menu, Rename the lighting more recognizable, open
the advanced property change, adjust the color, intensity, and check [Invisible] to hide the lighting source.

Then vou can do a test render of how it results.
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= |STEP 03] Cu:np} the plane Ilghtmg for other windows in the SketchUp model. You may adjust the size of the plane lights
with scale. The copied plane lights will have the same lighting properties as the original resource.
Confirm the result on the test interactive render.
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Tip. You can use a [Plane light| for a rectangular shape lighting surface. You can use |Sphere light] for the round surface/

spherical shape of an object.
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Add V-Ray lighting source — IES lighting

V-Ray lights support a .ies file which contains the lighting profile/footprint for a light. If you use IES lighting in V-Ray, your
rendering will look more realistic.

= |STEP 01] You must download/be ready for a .ies file first for adding an 1ES lighting.
You can download 1ES sources from the 1ES Library website or from lighting manufacturer websites.

« |STEP 02] Once you download a .ies file, click [IES Light| on the V-Ray toolbar. It will ask where the ies file is. Select the
file to add to the model.
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« [STEP 03] Once you place the 1ES light in the model, you can position it as you wish. Then open [V-Ray Asset Editor|,

rename the light more recognizable, and open the advanced setting to change the color and intensity. After you change

the setting, test it with interactive rendering to check it looks right.
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(CO5) Understand the Final render and save the image

Final render setting

Once your SketchUp model, materials, and lights are ready for a final render, you can turn off the [Interactive] render and turn
on [Progressive] and click [Render with V-Ray]. It may differ from the Interactive render, so may need some adjustments to get
things right. For example, often, you need to adjust the Exposure Value and Aerial Perspective. You will get a JPG, PNG, or
TIFF file from this final render for your post-production, known as photoshopping. The final render will take a few minutes to
a few hours depending on the size of the image and the complexity of the model imore points), material settings (reflectivity,
bump, displacements), and number of lighting sources.

« |STEP 01| Make sure all settings are suitable for your final render. I recommend testing the V-Ray render with a small
rendering with draft quality to confirm the settings.
For a preview of the final render, you can use [Regin Render| and [Track Mouse| to see the desired area of the rendering.
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= |[STEP 02] Render setting.

= Turn off [Interactive| under Render and turn on [Progressive|.
= Adjust Exposure Value under Camera on the Asset Editor for the best result. You can confirm the [Force Color

Clamping| tool on the Frame buffer to check too bright area avoid the blue color area.
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= Change Render size and ratio - Typically, you can render 2400 pixels x 1350 pixels for a digital presentation. For a
print version presentation like panel presentation, vou can render 4800 pixels x 2700 pixels.

= Change render quality to Medium. Based on the instructer's experience, Medium quality would be acceptable fora
final render. It can save much more time.

= You may turn on Caustics if you render any water-like elements.

= Change Antialiasing Filter under Raytace to [Catmull Rom]with value 4.
@OPEEE SO D eD0 0 R GOV =7 GEAW S8y
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: Consider adding Render Elements, for example, Background, Material 1D, Object 1D, Shadow, Lighting, and ZDepth
for your post-production of the rendering. Once you add these elements, you will get the separated imaged files with

the original rendered image file.
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« [STEP 3| Click |Render with V-Ray] butron.

« |STEP 4] After the render is finished, vou can modify the final image with [Correction Control] and [Lens effect settings|.

« |STEP 5] Click |Save current channel| to save the rendered image shown in the frame buffer. If you want to save all render
elements that you added, press the [Save current channel| and release the click on |Save all image channels to separate

files].
GONAEE SOt a0 s e e0eRe = CGQUe O

« |STEP &| Save the image - if you want to save the rendered image with the background (skyl image, save it in [PG format.
If you want to save the rendered image without the background (skyh image, save it in PNG format. If you don’t want to

get the highest image quality, save in TIFF format.
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Chapter 16. Lumion - User interface and
import 3D model

Session ':.-1||‘.'l.'L'I'.i'I £s

Upon completing this session, students will be able to:

» |(CO 1) Be introduced to Various Rendering software
« (CO 2} Install Lumion Pro Student

» (CO 3) Understand the interface

» |CO 4} Import a 3D model

‘¥ Session Highlights

At the end of the session, students will be able to create the graphics below.

E Lecture Contents

(CO1) Be introduced to Various Rendering software

Please read these articles for your information. My lecture contents come from these articles, please read these liked pages.
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1. Top9 Best Rendering Software for Architects This Year.

2. Best 3D Rendering Software (Some are Free)

3. Young Architect Guide: 11 Top Rendering Software Apps and Plugins by Mathan Bahadursingh.

Junior designers might assume most 3D modeling software has a 3D rendering function. The short answer is Yes. However,
the render gquality from 3D modeling software is not guaranteed. For example, SketchUp, Rhino, AutoCAD, and Revit
have rendering function, but it only supports essential quality, no raytracing lighting, no quality textures. There are many
standalone or plug-in 3D rendering software in the market. In this course, we will discuss the pros and cons of various

rendering software and learn one rendering software (Lumion}.

Various Rendering Software for Interior Designers and Architects

Enscape

image credit Andrew
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Enscape is a real-time 3D rendering software where everything is prepared in the original program. This software is primarily

geared at architectural visualization.
Available for Revit, SketchUp, Rhino, ArchiCAD, and Vectorworks.

Fros
«  User-friendly Ul and easy to learn.
«  Fast render time and reasonably high-guality render ourputs.

+ Support various outputs - VR presentation, EXE, Panorama view, and animation.

«  Great collections of libraries.
Cons

« Lack of customization, the render outputs look similar.
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V-Ray by Chaos Group

image credit: andykersiens

V-Ray by Chaos Group offers state-of-the-art rendering technology, capable of powering the most advanced photorealistic
images. Renowned for its versatility, V-Ray can be integrated with a slew of rendering applications. V-Ray's quality, power,
speed, along with the creative control it offers users can explain why this software is deemed as an industry standard amongst

artists and designers,
Available for 3ds Max, Sketchup, Rhino, Revit, and Unreal, and more.

Pros

«  Users can specify a complex rendering environment. The user can control everything in the render.
« Mot high hardware specifications are required.

+ The exhaustive list of fearures and tools.

«  Anincredible array of models and textures to work with.

+ Fairly competitive price.
Cons

«  New learners might find this intimidating.

+ Lower render time.
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Corona Renderer

imagre credi: Nguyen Ba
Dung
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Corona Renderer is one of the newer rendering software on the market, but how it performs as a renderer makes it stand out.
Available for Autodesk 3Ds Max, Cinema 4D, and Standalone application.

Fros
+ One of the fastest rendering software in the market.
= Clean animations and excellent light effects.
«  Affordable price with a one-time purchase,

Cons

« Some features missing, like velocity render.
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Lumion

image credit Gui
Giovanoni

Lumion is a 3D rendering software that has been developed to integrate with CAD software. Its ease of use makes it suitable
for designers and architects who want to render in-house. Lumion includes an extensive library of skies, water, landscape
modeling.

Available for Revit, SketchUp, and any 3D model that can be exported FBX file.

FPros

« Compatible with every other rendering software on the marker.
+ Easy to use Ul and friendly learning curve.

+ The student license is free.

« Best for architecture video animation.

+ Real-time rendering,.
Cons

+ The required highest specification of hardware requirements.
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Twinmotion

imagye credit: Pasquale
Scionti

Twinmotion is a real-time 3D immersion software that produces high-quality images, panoramas, and standard or 360 VR
videos in seconds. It is designed to help architecture, construction, urban planning, and landscaping professionals better
communicate their designs by offering a simple and intuitive interface backed by the power of the Unreal Engine.

Available for a plug-in for Revit, SketchUp, Rhino, and ArchiCAD.

Fros
« Compatible with every other rendering software on the market.
« Easyto use Ul and friendly learning curve.
+ The student license is free.
+ Good for architecture video animation,
+ Real-time rendering.

Cons

« Required higher specification of hardware requirements,
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Twinmotion V5. Lumion

If you know maore about the two applications, please watch these linked videos.

1. Twinmotion 2019 vs Lumion @ by Desizner Hacks.
9 ; . . ;

Blender

image credit: Michal
Franczok
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Blender is an open-source 3D modeling and 3D rendering software. It is one of the most powerful rendering tools. This

software is not only for interior designers but also for animators or any 3D designer.
[t is standalone 3D modeling with 3D rendering software.

Pros

- FREE.
«  Extremely capable renderer.
+ Resourceful and helpful community.

Cons

+ It has got a learning curve that does take time to master this software.
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(CO2) Install Lumion Pro Student

Visit the Lumion Reguirements website for the system requirements and see the recommended requirements before

downloading the software.

If vour hardware can support running Lumion, please visit the Lumion for Students site to download Lumion Pro Student.

If your hardware cannot support running Lumion, please use the CoD lab computer by using VMware Horizontal Client.

Lumion 2.5 is currently installed in CoD} remote computers.

Install Lumion LiveSync for Revit from the Lumion Support website.

(CO3) Understand the interface

Welcome page

Open Lumion application. If this is the first time to open the application, the software will run a benchmark test to knew your
hardware can run this application or not.

Once Lumion is open, you can see the welcome page.

« O this page, vou can create a new file by clicking one of the six presers.
» You can find a link for online tutorials that Lumion provided.
+ You can see your computer speed.

« You can also change languages and adjust setrings.

Chapter 16, Lumion - User interface and import 30 model | 265



Once you click the setting, you can adjust the unit, the working resolution, and the use of a tabler.
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Once you create a new Lumion file by clicking [Plain], vou can see this view below.

Anytime you need information for the interface, mouse over the question mark.
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Please be familiar with navigating the view.

« WASD for directions and

» QE for moving up and down.
«  [Shift] key for faster moving.

+  |Space] key for slower-moving,

»  [Mouse-right| click for rotating view.
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« Hold the [O] key and vuse [Mouse-right| click to rotate the camera.
« Hold the |Ctrl] key to select an object by drag.

« Click the top-right camera icon to set your eve level ar 33",

To save, open, or create a new file, click the disk icon

You can save the file by clicking |Save as|.
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+ To open an existing file, click the |Folder] icon.
= To open an example file, click the [Grid] icon.
« Tocreate a new file, click the |[Home| icon.

(CO4) Import a 3D model

This tutorial demonstrates how to export/import the Revit model for the Lumion fle using the Eames House model. For
Exercise 4, you can use the Eames house model (Download from Canvas Modul), or you can use your own Revit model that vou

used for o previous project at the Junior level to update your portfolio.

Prepare your Revit model for Lumion

« |STEP 01) Open the Eames house model, you can download the Revit file from this external Box folder.

« |STEP 02] Open a 3D view, Use section box to crop the 30 view.
« [STEFP 03] Hide plants, imported 2D drawings, unnecessary elements for renderings.
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Export the Revit model using Lumion LiveSync Export

= |STEP 01] make sure you downloaded and installed [Lumion LiveSync for Revit] from the Lumion LiveSvoc for Revit
download page.

= Before the installation, you must turn in the application.

« |STEP 02] If vou use Lumion on vour computer, click [Setting| from |Lumion] tab, under [Live5ync| panel.
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= Update the insertion point to [Survey Point{true north),
= Update Surface smoothing to [High).
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= Check [Camera sync on start].
= Click |OK] to finish the setting.
= Click |Start LiveSync| to insert the model into the Lumion file.
« [STEP 03] If vou use Lumion on the CoD lab computer remotely, click [Export).

= Update the insertion point to [Survey Pointitrue northj|.
= Update Surface smoothing to [High).
= Check [Collect textures].
= Check [Export nodes).
= Click |[Export].
= Save the file in [DAE] formar,
« |STEP 04] Open |VMware Horizontal Clients] and log in to [Design Teaching Labs).
« |STEP 05] Copy the exported DAE file to the Desktop. You can download the DAE file from this shared Box folder.

Import the Revit model in the Lumion file

[STEP 01] Click [Tmport] = find the exported Revit file = Click [Open] to place the model.

Lurmion Pro EludE'lt

S mrm lmrry i Py e A

« |STEP 02| Click a position to place the imported model and press [ESC] to close the command = Click [Select] icon and

use the move toal to adjust the position.
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« |STEP 03] Double-click the imported model to see the model as a whaole.

Mouse right double-click to jump onto the surface.

Lumion Pro Student

Make sure the file is saved in your project folder. If you are working on this project using the CoD lab computer remotely, vou

must copy the working file to YOUR project folder. When you disconnect, the file will be removed automatically.

Don't forget to save a backup file.
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Chapter 17. Lumion - surroundings, objects,
and materials

Session O ||‘.I EClIvVEeS

Upon completing this session, students will be able to:

» (CO 1) Add surroundings
+ (CO 2} Add/edit materials
+ (CO 3) Add objects

¥ session Highlights

At the end of the session, students will be able to create the graphics below.
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(CO1) Add surroundings

Change Weather

Lumion has several presets for Sky and can change the direction of the sun and time of date quickly. Lumion is a rendering

software, so it does not need precise data for the renderings.

[STEP 01] Click [Weather| tab.

[STEP 02] Adjust [Sun direction].

[STEP 03] Adjust [Sun height].

[STEP 04] Adjust |Amount of cloud].

[STEP 05] Adjust [Amount of sunlight].

[STEP 0&] Change [Cloud type] by clicking the [Cloud| icon and selecting one of nine clouds.

Edit Landscape

Lumion landscape allows you to create terrain height change, add water, add ocean, change landscape types.

[STEP 01| Adjusting terrain height.

= Click the |Landscape| tab.
= Click [Height| icon.
= Select the size of the circle and the speed of the creation.

= Select |Raise|, |[Lower|, |Flatten], [Jitter], and [Smooth| to modify the shape of terrain.
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+ [STEP 02| To match the landscape texture with your Revit model.
= Click |Paint] tab.
Hoover over the mouse to select the landscape surface that vou want to change.

= Select the [Landscape| icon from [Material library],
= Click the |Check mark] to complete the command.

« |STEP 03] If vou want to add water or ocean, click the icons and place them on your surface.
+ [STEP 04| To change the landscape texture type.
= (Click the |Paint] icon.
Select the landscape image to change the landscape tvpe. You have 20 options for vour landscape type.
= Adjust the bar to change the texture size.
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« [STEP 03] You can turn on/off landscape (3D) grass option. This function should be activared when you render to save

your speed of wark.

= Save the file frequently.

(CO2) Add/edit materials

When you import a Revit file, you need to convert the materials to Lumion material. This is a typical process for most
standalone rendering software. When vou exported, the textures(images) would be created in a separate folder. You can use the

texture, you can use textures in your project folder, or you can rely on Lumion preset texture.
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In this tutorial, you will learn how to add Lumion texture from the material librarv and convert the existing material to Lumion

material.

Add materials

« [STEP 01] Click [Material Editor| tab.

« |STEP 02| Select a model (surface) vou want to change {In this tutorial, I choose the curtain wall glass).

= |STEP 03] Select [Qutdoor] tab from the [Material library] = Click [Glass] category = Click a type glass fram the list. You
can find more by navigating the tabs.

+ |STEP 04] Once you finished the change, click the [checkmark] on the right bottom corner to complete the command.

Edit materials

« |STEP 01] Click |Material Editor| tab.

« |STEP 02| Select a model (surface) vou want to change (In this tutorial, I choose the wood panel wall).

« |STEP 03] Select [Indoor] tab from the [Material library] = Click [Wood| category = Click a type wood from the list. You
can find more by navigating the tabs.

« |STEP 04| Once the material is applied, see the direction of the texture, size of the map, and any changes needed. If you
need to edit the material that you apply, double-click to enter [Material Properties).

« |STEP 05| On the [Material Properties| panel, you can change the properties. By clicking the arrow to the bottom, you can
edit in advanced mode.

« |STEP D8] Once you finished the change, click the [checkmark] on the right bottom corner to complete the command.
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Convert a Revit material to a Lumion material

« |STEP 01] Click [Material Editor| tab.
« |STEP 02] Select a model (surface) vou want to change |In this tutorial, | choose the Concert retaining walll.
« |STEP 03] Select |Standard] from [Custom]| tab on the [Material library].

Matarial ey

« |STEP 04| On the [Material Properties| panel, you can change the properties. By clicking the arrow to the bottom, you can
edit in advanced mode.
« [STEP 08) Once you finished the change, click the [checkmark] on the right bottom corner to complete the command.

Please use these three material mapping strategies to apply all material on the exterior and interior.
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(CO3) Add objects

Add objects

Lumion provides lots of objects for your rendering. Mature, Transports, People and animals, Outdoor objects, Indoor objects.

Please navigate the object library and use it for your rendering.

+ [STEP 01] Click [Objects] tab.
« |STEP 02| Select a category then the library will open = Select a sub-category = Select a page > Select an object to place.
= |STEP 03] Place on the top of the model.

There are three methods of placement [Single placement| [Mass placement|, and [Cluster placement]. Please practice

these placement methods in this exercise.
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« [STEP 04] If vou want 1o move or rotate the object that vou placed, select the object by holding the [Crrl] key and select
the object key = Click one of the options (Rotate, Move, or Delete) on the menu > Adjust the value or drag the position.
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« |STEP 05] Once you select the object, you can adjust the properties, such as coloring, transparency, and maore if the

object allows.

Once your object placements are done, please save the file.
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Chapter 18. Lumion - Lightings, scenes, and
outputs
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Upon completing this session, students will be able to:

« [CO 1) Add/edit lighting
+ |CO 2} Add/edit scenes
» |CO 3} Render outputs

¥ session Highlights

At the end of the session, students will be able to create the graphics below.

@ Lecture Contents

(CO1) Add/edit lighting

In order to work on the lighting in a scene, it is the best practice to change the time of the date to night time like sunset time,
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Change a Revit material to Emissive material

This Emissive material option your material source glow. However, this option is not enough to show the lighting effect.

+ [STEP 01| Click [Material Editor] tab.
+ [STEP 02| Click a material that vou want to change to Emissive material.
+ |STEP 03] Click |Standard| from the [Material Editor] » [Costom)| tab.
+ [STEP 04| Click |Advanced option] and click [Setting] tab.
+ [STEP 05] Change the bar value for [Emissive].
If needed, change the transparency value, and the color of the object.

+ [STEP 0&] Once the materials changed, click the [Checkmark]| to complete these changes.
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Lumion Pro Student

Muiansl Propertees

Add lights

Lumion supports three types of lighting sources, Ommni light, spotlight, and Area light, Please practice all different types of

lighting sources

[STEP 01] Click [Objects| tab.

+ [STEP 02] Click [Lights and Utilities], then [Lights and Utilities Library] will open.

« |STEP 03] Select a type of light that you want to add.

+ |[STEP 04| Place the light on the view by hovering and clicking on a surface of an object.

Lumion Pro Studont
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Edit lights

= |[STEP 01] Select the lights that you want to edit the color and brightness of the light. You can select individually, or you
can also hold the [Crrl] key to the window selection.
« |STEP 02] Adjust the setting on the right-top menu.
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(CO2) Add/edit scenes

Before starting the rendering, you must set scenes (camera views) first.

Chapter 18. Lumion - Lightings, scenes, and outputs | 283



To add a scene

= |[STEP 01| Stop at a position that you want to capture. Make sure the time of the date is what you want to render.
« [STEP 02] Click [Photo| from the main menu.

LURi0n BeotS (chent

« [STEP 03] Afier the Photo view opens, adjust camera [Focal length], [Horizental eye level], and [Set eve level).

[STEP (4] To save the scene, hover aver the views on the bottom screen. And click [Store camera).

73 Cuniom Style

« |STEP 05] You can rename the scenes by clicking the photo below. And also, you can update the scene by clicking [Store

cameral.
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Styles and effects

Lumion provides eight distinct rendering styles and sixth-three photo effects for the rendering,

To change a render style

« |STEP 01] Select a view.
« |STEP 02] Click |Custom Style] on the left top corner,
« [STEP 03] Select one of the nine styles to start setting your rendering.

« [STEP 04| Once you add a style, vou can adjust the effect detail by clicking each of the effects and changing the values.
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To add a new effect

« |STEP 01| On a photo mode, click [FX] under the rendering style.
|STEF 02] See what effect under the Seven categories, and select a photo effect that you want to add.

[STEP 03] You can adjust the detailed value for your rendering. If you want to see the effect, you can turn it on and off by

clicking the eye icon. Moreover,, vou can delete the effect anytime.
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Repeat step 1 to step 3 for all other scenes,

(CO3) Render outputs

Rendering scenes

[STEP 01] Once all your scenes are ready for render, click the [Render Photo] icon to render.
pr

£52 Inborior

|STEF 02] For a single rendering, use the [Current Shot] tab. For multiple renderings, click the [Photo Set] tab.
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« [STEF 03] Select any additional output that vou want to get. [ prefer, D-Depthmap, A-Sky alpha map, and M-Material 1D
map for photoshop.
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The final renderings.

Chapter 18. Lumion - Lightings, scenes, and outputs | 289



Chapter 19. Photoshop - brushes and quick
retouch

Session ':._1|!‘.|r.'L'I'.i'I Es

Upon completing this session, students will be able to:

» |CO 1) Be aware of various tips and skills for better interior perspective renderings
+ (CO 2} Be introduced to various sites for texture, cutouts, and more for references
« |CO 3) Be able to produce a rendering with a quick retouch

¥ session Highlights

At the end of the session, students can create the graphics below.
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E Lecture Contents

(CO1) Be aware of various tips and skills for better interior perspective
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8 Tips for better perspective renderings

« |[STORY| Make a story in the view with a sketch and references.

+ [MODELING]| Build a detailed main model for your design.

« [SURROUNDINGS] Use additienal surroundings, such as nature, buildings, landscaping, objects, figures, and details.
The surroundings can be photoshopped or used 3d models.

« |[COMPOSITION| Consider appropriate composition such as asymmetry, two-point perspective, 3-ground rule: fore,
mid, and back, Field of View: not too wide, not too narrow.

« |LIGHTING] Develop realistic lightings in your view, use light profiles, use fake lightings.

« |[MATERIAL| Use physically real materials and textures - Texture size, image quality, seamless pattern, bumpiness,
reflectiveness, and more.

+ |[MOOD| Avoid using too many colors on your image and too bright image, considering the mood of the view.

= |CREATIVITY] Avoid photorealistic rendering, unleash vour imagination!! be creative!! & be bald!!

The information above is from 12 Tips for creating a perfect architectural rendering - From the exports bv Paul Keskevs

Websites for Rendering awards

CGarchitect Architectural 3D awards - CGarchitecture is one of the leading online magazines in architectural design
visualization launched in 2001 by Jeff Mottle (CGarchitect, n.d.).

image credir: CGarchitect
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1 - ASAlL is a professional organization w represent the
architectural illustrators in the world founded in 1986 by Steve Rich, Frank Costantine, and Steve Oles (ASAL n.d.).
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The one rendering challenge by Architizer - Architizer is the world's largest online community of architects to empower and
connect architects with building products and inspire them {Architizer, n.d.).

The best architecture drawing of the vear by Achidaily.

+ The Best Architecture Drawings of 2019
= The Best Architecture Drawings of 2018
+ The Best Architecture Drawings of 2017

Bee Breeders competition results.

iy BEE BREEDEHRS ANCHITECTUSE COMPETITIONS  LAUNGH & COMPETITION  NEWS & LOG =} image credit: Bee Breeders

Monte NOiro Wine Tasting Room Eurgi Ohservation Tower HE Stock London Housing
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(CO2) Be introduced to various sites for texture, cutouts, and more for
references

Websites for texture

« Siroffel Productions
+ [Joao Paulo

« Texture Haven

+ Textures.com

« Poliigon

Websites for cutouts

+ Skalpubbar
+ Nonscandinavia

« Mr. Cutout

+ Pimp myv drawing
+« Cutoutmix

Websites for 3D modeling

«  Evermotion - This website is one of the best professional websites for 3D modeling, textures, backgrounds, and cutours

Architectural visualization tutorials - photoshop

+ OB Tutorial on YouTube
»  Upstairs Tutoerial on YouTube
+ Show [t Berter Tutorial on YouTube

(CO3) Be able to produce a rendering with a quick retouch

In this tutorial, I will demonstrate how to make a quick retouch from Enscape render outputs.

« [STEF 01] Render setting with [Export Object-1D, Material-10, and Depth Channel].

Chapter 19. Photoshop - brushes and quick retouch | 293



[ T e e

G - ..;-f'; |HH m & = a5 & L M = @ =g
..._..- s [P g p— —— -
] L ; 7 TE—— :...u..._-.__...... 0 ”__,

[STEP 03] Open the rendered image without an entourage in Photoshop.

[STEP (4] Save as the file in PSD format.

[SETP 03] Duplicate the background laver by mouse-right clicking and selecting [Duplicate Layer..| or Selecting all
|Cerl+A] and [Ctrl+]).

-
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[STEP 0&] Click [Camera Raw]| from the [Filter] menu. The [Camera Raw] setting is a combination version of image
adjustment sertings.
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[STEF 07| Add the [Depth Channal| by dragging and dropping it on the file.
[STEP 08] Click |Color Range| from the |Select] menu, and click the black part.

[STEP (9] Select [Image with camera raw] layer and press |Shift+Ctrl+1] for invert selection » Press |Ctrl+]] to duplicate

the selected area = hide the [Image with camera raw] layer.

|[STEP 10] Search in google |Landscape HD background| and save an image that vou want to use as a background of your
rendering > Add the downloaded image an the file under the image with camera raw + no back| layer » Adjust the image
size by pressing [Crrl+T).
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image credic The
backgroumd image was
modified by the author

Adobe Stock, Standard
Licensa.

« |STEP 11] Adjust the image color and brightness with the [Camera Raw| filter to match the rendered image. Consider the
background image for the interior view is normally brighter than the interior view.
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[STEP 12| Show the |Depth Channal] layer = Apply [Invert| by pressing |Cerl+[] = Apply [Level| by pressing |Ctrl+L| and
adjust the value like the image below.
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[STEP 13] Change the [Depth Channal| layer style to [Color Burn| the opacity change to [20%)].
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» [STEP 14| Add the rendered image with the entourage and the material ID image in the file = Select the people on the
material ID image using the [Mogic Wand Tool| = hide the material ID image layer.
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= |STEP 15] copy the peaple from the rendered image layer to a new layer by pressing [Ctrl+]| » Change the layer Opacity to
30%.

= |STEP 18] Copy the people layer by pressing [Ctrl+]] = Chang the layer Opacity to 70%.
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[STEP 17| Show the material ID layer and the rendered image > Select light material that needs to be glow = copy the
selected area from the rendered image = Update the layer name to Lights = copy the Lights layer > hide the ariginal

Lights layer = change the layer style of the copied Lights layer to [Hard light] = Add [Gaussian Blur] filter with 40 px =
copy the copied Lights laver > Add [Gaussian Blur] filter with 100 px.
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[STEP 18] Select the imported landscape image as the background, the rendered image without background, and the

depth channel = Duplicate the layer = Convert to Smart Object by mouse right-click.
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« [STEP 20] Change the layer stvle to [Overlay] and change the layer Opacity to [20%] = Copy the layer and change the layer
style to [Screen].
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[STEF 21] On the top of the layer, add [Color Lookup] and select a 3D LUT file that makes the best for your rendering.
This function creates a unified color for all layers.
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Save the file and Save as to the JPG file.
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Chapter 20. Photoshop - Advanced rendering
post-production
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Upon completing this session, students will be able to:

» |CO 1) Understand photoshop brushes and Wacom tablet

« (CO 2) Understand post-production for exterior perspective rendering

¥ session Highlights

At the end of the session, students will be able to create the graphics below.
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(CO1) Understand photoshop brushes and Wacom tablet

Photoshop Brush

Designers use the [Brush| tool to draw any shapes and lines with their mouse and Wacom tablet. After selecting a brush, you
can draw simply by clicking the left mouse button a single time, or by holding it down and dragging your cursor around the
page to create multiple marks with a single stroke.

Despite the term “brush,” vou can use brushes for much more than just replicating physical media like paints. In fact, brushes
can be used for everything from textures and patterns to lighting. The ease of use and versatility of this tool makes it a handy
resource for both the novice and the expert designer to add depth to your projects.

Photoshop supports basic brushes, but you can import/load brushes (ABR file).

Refer to Creative Market's page on how to install Photoshop brushes for more information.

Useful photoshop brush sets (free resource)

« ARQUI? - Architectural brush sets

« Show It Better - Architectural brush sets
+ Clouds

» Light rays

« IES lights

« Lens flares

Import Brushes

« [STEF 01] Open [Brush] panel.
« [STEP 02) Click settings.
« [STEP 03] Select |Import Brushes| and check [Brush Tips| to see a single brush = Click an ABR file and click [LOAD).
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Use [Brush] tool

« |STEP 01] Click [Brush| tool, or press [B].

« [STEP 02] Select a brush.

« |STEP 03] Change the size, opacity, mode, hardness, and color.
« |STEP 04) Click or Drag to apply the selected brush.
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(CO2) Understand post-production for exterior perspective rendering

In this ttorial, I will demonstrate a post-production process of exterior perspective rendering. Some of the information is the

same as CO3J in session 19,

+ |STEP 01| Render setting with |[Export Object-1D, Material-1D, and Depth Channel|, decide the best time of the day that
you would like to show the concept of the space, and think the (CO 1) 8 tips for better perspective renderings in Session
19

+ |STEP 02| Open the rendered image in Photoshop.

= |STEP 03] Save as the file in PSD format.

« [STPE 04) Duplicate the background layer by mouse-right clicking and selecting [Duplicare Layer..| or Select all [Crrl+A)|
and [Ctel+]].

= |STEP 05] Click [Camera Raw] from the [Filter] menu. The [Camera Raw] setting is a combination version of image

adjustment sertings.
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« [STEF 0&] Add the [Depth Channal] and the [Material ID] by dragging and dropping on the file.
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[STEF 07| Use [Crop| tool, pressing [C] and change the region 1o show more the sky
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« [STEP 08] Click [Color range] from |Select] menu = select the black = click [OK].
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« [STEP 09 Hide [Materal 1D] and [Depth Channel| = Select |Randered image| layer = Invert select by pressing [Crrl+Shift+]|

= Duplicate the selected area to a new layer by pressing [Ctrl+]| = Laver name change [Rendered image+No sky] = Hide
[Render image| layer.
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= |STEP 10] Image search website [Sky HD background] and click advance search with [Large| size image and [copyright| if
needed.

« |STEP 11| Add the downloaded Sky image to the file » the laver must be below the rendered image = change the size and
locations of the sky image.
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[STEP 12] Adjust the color of the rendering or the sky to harmonize for both images by using [Color Balance] from
[Image| = [Adjustment] menu.
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+ |STEP 13| If needed, change the color or pattern of the materials by using the [Material 1D| layer to select the materials »

Add high-quality seamless texture = convert to a layer = change the color to match the original color of the texture.
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« [STEPF 14| Copy/size change the image to make a pattern > If needed, use [clone stamp| tool to remove the patern effects
= [f needed, use |Burn| tool or |Dodge| tool to add shadows and highlights = use [Mask| to hide the not needed area.
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+ |STEP 15] The rendering already has grass on the ground. However, [ will add plans on the grass and the concrete wall
using the [Brush] tool.

= Click |Brush| tool = Select [Herbe3| from |[Argui®LearnSet| = Click [Brush Settings| panel = adjust |Shape Dynamics| -
Size Jitter, adjust [Color Dynamics] - Foreground/Background Jitter and Hue Jitter.

= Change the foreground/background color.

= Create a new layer.
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= Click or hold the mouse or use the Wacom tablet.
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Use a different brush for the plans on the concrete wall and apply [Drop Dhadow] on the layer effect.
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[STEP 16| Download trees from image searching sites and add the images on the scene. You may need to only the tree
image without a background. You can use the [Color Range] tool to select the background and invert the selection, then

copy the tree image only. It would help if you also had color changes and layer apacity changes for a better look.
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« [STEP 17| For a dramatic effect, you can add [Ray of Light).
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« [STEP 18] On the top of the layer, |add adjustment of layer]. I like to use 2 Color Lookup with different opacity, Photo
Filter, and Brightness/Contrast.

312 | Chapter 20. Photoshop - Advanced rendering post-production



S e v B g v Sl s 18 1 s v | Lo SN

Save the file before closing.
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PART FIVE. 3D VIDEO ANIMATION

Chapter 21. Enscape - walk-through video

+  Be aware of various tips and skills for better interior 3D animation

Create a walk-through video in Enscpae

Chapter 22. Lumion - walk-through video

+ Create a walk-through video in Lumion

Chapter 23. Premiere - Video pro-production

+ Understand Adobe Premiere pro the User Interface
Add videos and titles
Edit videos and add transitions

«  Add/edit sounds
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Chapter 21. Enscape - walk-through video

Session Objectives

Upon completing this session, students will be able to:

» (CO 1) Be aware of various tips and skills for better interior 3D animation
» |CO 2) Create a walk-through video in Enscape

¥ 5ession Highlights

At the end of the session, students will be able to create the graphics below.

éﬂne or more interactive elements has been excluded from this version of the text. You can view them online here:

E.’ Lecture Contents

(CO1) Be aware of various tips and skills for better interior 3D animation

10 Tips for making a great movie

Camera work and movie structure

= [TIP 01] Use slow camera movements,
« [TIP 02] Use multiple clips.

« |TIP 03] Move the camera in one direction in each clip.
Artistic effects

+ |TIP 04] Use animated effects carefully.
= [TIP 05] Use volume lighting and lens flare carefully.
+ [TIP 06] Use the analog color lab or color correction.

Artention ta detail
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[TIP 07] Use a little bit of motion blur.
[TIP (8| Fade in and fade out of the main movie and between clips.

[TIF 09] Pick the right music and sound effects.
[TIP 10] Reflections.

-

-

Lumion has a tutorial on Tips for Making a Great Movie in Lumion.

Video examples

+ 3d Animation for Apartment Interior by Guangzhou Frontop
« Architectural animation of family house - LODEA from VESPER HOMES company by ARCHEVIO
+ Universitv of lowa Advancement Services Building Enscape Walkthrough by OPN architects

(CO2) Create a walk-through video in Enscape

To create a video path with scenes

« [STEP 1] Click “Video Editor” from the Enscape tab.
« |STEP 2| Click “Add keyframe" - Once vou click “Add keyframe,” ti'le setting will be saved.
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+ [STEF 3| Change the scene by moving the scene.

« |STEP 4] Once you think the next scene is in the right position (recommend foot walk to see the scene from the same
height), click “Add kevframe,” then you can see the second frame is added.
« [STEP 5] You may check the preview to see how this works.
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« |STEP &| Repeat steps 3 ta 5 to create a complete path for a video,
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« [STEFP 7| Click a [frame] and change the sertings (time of the day, duration of the movement, camera field of view, and

camera position| and click “Apply” to apply the changes.
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[STEP 8] You can repeat other frames to change the settings.
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[STEF 9] You can be out of the keyframe editor by clicking Back, Click Preview to see the results.
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To save a video path
+ [STEP 1] Click “Save Path” from the Enscape tab.
+ |STEP 2] Make a unique name for the path.
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To render the video

+ [STEP 1] Load camera path by clicking “Camera FPath” = “Load path” from the Enscape tab.

+ |STEP 2| Change video size from Visual Setting - Resolution (HD is recommended), the quality can be [Web|, FP§ must
be [30],

+ [STEP 3| Click “Render Video" to render the path.
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Note. To render the video, will take o while because of the pictures thar the video renders. Typically, if vou render a 1-second video,
Enscape renders 30 frames, If one frame rakes 10 seconds ro render, a rotal of 1-second Video takes 300 seconds to render. Enscape does
a great job because Revit rendering rakes 5 minurtes to render one frame.
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Chapter 22. Lumion - walk-through video

Session Objectives

Upon completing this session, students will be able to:

» (CO 1) Create a walk-through video in Lumion

® 5ession Highlights

At the end of the session, students will be able to create the graphics below.

iﬂne or more interactive elements has been excluded from this version of the text. You can view them online here:
thitnz - Masfate presshoolis pubiizualgraphiccomm 27 p=8680embed-1

E Lecture Contents

(CO1) Create a walk-through video in Lumion

This lecture content is based on ‘Architecture Inspirations’ Lumion Animation Tips and Tricks!

Animation basic

= |[STEP 01] From the [Build| mode, click movie| mode on your right-bottom menu.
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= Click a frame to add a clip. In this first clip, use the first frame.

= Click |[Recode| to start making a video.

[STEP 03] Create scenes.

Position your camera to create vour scene by using the [Focal Length|, [Horizontal Eye Level|, and |Set Eye Lavel].
Focal Length - recommended setting is 28mm ~ 32mm.

Horizontal Eye Level - Checked.

Set Eye Level - Checked.

You can capture the first scene by clicking the camera icon.

Move the scene by using [QWEASD| keys to move the camera.

Click the |[Camera] icon again to add another scene. [t will make a camera path.

Click the [Play] icon to confirm your clip looks good.
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= You can repeat this process complete a clip. | recommend having 2~4 scenes in a clip that makes the best result.

Simple is the best! Less is More!|
« |STEP 04] Adjust scenes.

= [f the clip moves too fast, change the duration of the time.

= [f you want to change a scene, move the camera, or change the setting of the camera, Then click the [refresh| icon to
replace the old scene with the new scene.

= You can also add scenes between two scenes.

= You can also delete scenes by clicking the [Trash Can| icon.

= Tocomplete the clip, click [Checkmark].

« |STEP 05| Change the style and add effects.
You can use the presets or add effects to the best outcomes of your movie. Just like your rendering.
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+ Recommended effects.

= Sun

= Volumetric Sunlight
= Motion Blur

= Depth of Field

= Exposure

= Color correction

= Lens Flare

» You can copy the effect to another clip by copying and pasting the effects.

« |STEP 0&) Render the clip.

= If vou want to render the clip, click the |Render Clip| icon on the clip.

= If vou want to render the entire movie, click [Render Movie] (Green icon).
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= Check the output quality is |Production Quality).
= Check the Frames per second is [30].
= And click one of the Render sizes [HD or Full HD| to start the video render.

Eddion Clp

Handar antrn Gl

= Define the file location and the file name to save.
= Once it starts to render, vou can see the process of the rendering. To make this 10-seconds clip, Lumion renders 100

frames. It took more than 5 minutes to complete the video render.

H  Randating ™ - Clip" - 1280x720 (.mpd)
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Add keyframes with effects (Cloud, Sun, Precipitation, and more)

The time-lapse effect is a technique whereby the frequency at which film frames are captured is much more spread out than

the frequency used by viewing the sequence. When played at normal speed, time appears to be moving fascer and thus lapsing.

= |STEP 01] If vou do not have the [Sun| effect, add [Sun| and open the |Sun] effect setting by clicking the effect on the clip.
« [STEP 02] Play the clip to find a frame you want to add a keyframe to set the [Sun height).
[STEP 03] Click |New Keyframe)]. You can find the icon on the right side of the

bar.

2% Realkstlc

Bar

« |STEP 04| Move to a different position of the clip by selecting the play bar.
» |[STEP 053] Add another Keyframe and change the slider bar ta change the Sun height.
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« [STEP 08] Click the play icon to see the preview,

Repeat this process for [Cloud| and [Precipitation).
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Animated objects and effect

Lumicn allows you to move/rotate an abject in your videa,

« |STEP 01] Click a clip to add the animated object effect.
= |STEP 02] Click [FX] = Click |Scene and animation| tab = Select [Advanced Move),

[STEP 03] Click |Edit] icon (look like a pen).

[STEF 04] Select the start point on the timeline. The camera can be moved to see the object better.

|[STEF 03] Select an object (human) and move to the stare point.
[STEP 06] Select the endpoint on the timeline.

[STEF 07| Select the object (human) and move to the endpoint.
[STEF 09] Click [Checkmark| to go back to the mode.

Repeat |STEP 04| to [STEP 08| for other abjects.
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TV screen effect

= |[STEP 01] Select the [Material Editor] tab on the [Build] mode.

« [STEP 02] Select a TV screen surface on the model.

« |STEP 03] If the surface does not have a Lumion Material, select |Standard| material.
= |[STEP 04| Click [Choose Color Map| = then a window browser will be open.

« [STEP 05] Select a video fle = Click [Open).

« |STEP 0&] Change the |Reflectivity| value and [Emissive] value.

= |[STEP 07] Click [Checkmark] to finish.
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Chapter 23. Premiere - Video pro-production

Session Objectives

Upon completing this session, students will be able to:

» |CO 1) Understand Adobe Premiere pro the User Interface
» (CO 2) Add videos and titles

« (CO 3) Edit videos and add transitions

» (CO 4) Add/edit sounds

® session Highlights

At the end of the session, students will be able to create graphics like those below.

iﬂne or more interactive elements has been excluded from this version of the text. You can view them online here:

Ihttps-Hiastate pressbooks. pubfvisusigraphiccomm 2/7p=8880embed-1

E Lecture Contents

(CO1) Understand Adobe Premiere pro the User Interface

This lecture content is for an entry-level student learning video editing.

“Premiere Pro is the industry-leading video editing software for film, TV, and the web. Creative tools, integration with other

apps and services, and the power of Adobe Sensei help vou craft footage into polished films and videos™ (Adobe, n.d.).

Please watch this Adobe tutorial video for information about using Premiere Pro panels and tools.

COince you open the application, you can see this Welcome page.

« [STEP 01| To create a new file, click [Mew Project].
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[STEP 02] Add the project name and define the file location where you will save the file and vour other resources (video
sources and audio sources).
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You may find this error message because of the svstem requirements, but vou can ignore the issue.
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User interface

Modes: Premiere Pro provides different modes for learning, editing, audio, graphics, and more. EDITING mode is

recommended for regular use.

Project Panel: This is where vou place links (video clips, audio files, images, and sequences) to your project. You can create
bins (aka folders| to organize the assets you use.
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+ Media Browser: Browse vour hard drive to find files.

« Effects: all effects you will use in your sequences.

Timeline Panel and Tracks: This is where you will do most of your editing. You can cut, move, and edit scenes. Tracks are like

layers. There are video layers and audio layers within the timeline.
Tool Panel: to edit the video, use the tool panel. This includes various tools for adjusting the files in your timeline.

Source Monitor: This screen allows you to view and trim the original clips.
« Effect control: Once you apply an effect, you can control the effect on this panel.

Program monitor: This is for viewing your edited sequence.

For more about the user interface information, please refer to the Adobe Press website.

(CO2) Add videos and titles

Before you import your sources ivideo files, audio files, and images), gather all the sources together in a project folder.

= @
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Import sources

-

[STEP 01] Double click [Import media to start] from the [Project Panel|.
|[STEF 02] Select all sources that vou want to add/edit to the project.
[STEP 03] Click [Open| to import the sources,

[STEP (4] You can switch the view to list view, [con view, and freeform view.

-

-
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Add the sources to the Timeline

= |STEP D1] Select a source from [Frojec Panel].

+ [STEP 02| Drag the source to the [Timeling| in the [V1] track.

+ |STEP 03] Repeat steps 1 and 2 for other videos and images you want to add to the [Timeline|. You can add videos in the
[V1] Track, and add images in the [V2] track.

+ [STEP 04| Change the sequence of the video and image with the [Selection tool).

i
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Add a title

= [STEP 01| Click the [Type Tool| from the |Toal Panel].

+ [STEP 02| Drag and drop to create a text box.

+ [STEP 03] Add text.

= |STEP 04| Open |Effect Contrel panel] by clicking |[Effect Control].

+ [STEP 05] Click [Text] to change the font, size, and position of your placed text.
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Edit the title

« [STEP 01] See more options from the effect control panel.

« |STEP 02| Click the Timeline or double-click the time and enter the numbers that the changes need to be made.
= [STEP 03] Add the [Stop watch] icon from the [Effect Contrals] panel on the effect to add to the first keyframe.

+ [STEP 04| Change the value for the keyframe if needed.

« |STEP 05] Change the Timeline,

» |[STEP D& Add the second keyframe.

+ [STEP 07| Change the value for the second kevframe.

« |STEP 08) Confirm that the changes are all right by pressing [Space bar|.
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(CO3) Edit videos and add transitions

Edit a video clip

« |STOP 01] Hide layers that you do not need to edit by clicking the |Eye] icon on the track.
= [STEP 02] Find a time frame you want to cut from the Timeline.
+ [STEP 03] Select the |[Razor Tool| and click the time frame to cut the video clip.
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« |STEP 04| Move the time frame you want to cut from the Timeline.
+ [STEP 05| Click the time frame to cut the video clip.
+ [STEP 06| Select the edited clip and move or delete.

« |STEP 07] Repeat this process to make the right sequence for your video clips and images.
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Edit a still image

« |STEP 01] Click the still image that you want to change on the [Timeline|.
« |STEP 02| Double-click the still image from the [Program Panel|.
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+ [STEP 03] See the |[Effect Controls| panel, and change the scale and position that you want to present.

« |STEP 04 If you want to make a moving image, use the kevframes.
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Add descriptions using texts

= |STEP 01] Click the [Type Tool| from the [Toal Panel].

+ [STEP 02| Drag and drop to create a text box.

+ |STEP 03] Add texts.

« |STEP 04| Open |[Effect Control panel] by clicking |[Effect Control].
+ [STEP 05| Click |Text| and change the font, size, and position.

Add rransitions between clips

« |STEP 01] Click [Effect| from the |Project panel|.

« |STEP 02] Open [Video Transitions| = |Dissolve].

+ [STEP 03] Click [Cross Dissolve] or [Dip to black] {if you want a different transition, please try).

« |STEP 04| Drag the dissolve and drop on the between the video clips.

« |STEP 03] Adjust the length of the transition by dragging and dropping the effect on the Timeline.
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+ |[STEP Da| Repeat this process for all other transitions.
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(CO4) Add/edit sounds

If you want to add music, [ recommend using a website that includes open-source instrumental music sources. For example,
see the Free Music Archive.

This source is free to share and adapt for non-commercial use with reference (CC-BY-NC).

I already downloaded Pictures_of_the_Floating World_-_Waves.mp3 and imported it into the project.
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Add and edit the audio source

+ [STEP 01| If vou did not import the sound source, impart the source first.
+ [STEP 02] Select the imported sound source.

« |STEP 03] Drag and drop the source on the Timeline under the Audio track.

panres Moo Lpog

+ [STEP 04] If the sound source is longer than the total length of the video, you can cut the sound source using the [Razor
Tool| and delete the remaining part.
« [STEP 053] You

also edit the volume level of the sound source by adding the keyframes and editing the values.
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Export to a video file

+ [STEP 01| Save the file before export to a video file.

+ [STEP 02] Click [File] = Click [Export] = Click [Media].

« |STEP 03| Confirm the Format is H.264, Check both [Export Video| and [Export Audia|, and Confirm the file name and
location.

+ [STEP 04] Click [Export] and check the final result once the processing is done.
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Appendix: Ancillaries

+ File package for a student - Download

= Spurce models

= Material images

+ File package for an instructor - Request to the author via email
iyongveonaisstate.edu or chovongveon 1983w pmail.com) with documentation, they are a faculty member.

= Source models
= Material images
= [llustrator, Depthmap X, Painter, Revit-SkerchUp, Vray, and Lumion models

Recommended lecture schedule and to-do list for each session:
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Week Session Contents
Image searching techniques & Diagramming
o1
+ The importance of visual communication and various carrent skills and technigues
*  Various image searching tips
«  Understand public domain media and Creative Commons media
* Understand what a diagram is, and the types of dingrammatic representations
]
Adobe Illustrator - Basic
o2
« What a dingram is, and the tvpes of dingrammatic representations.
«  Use basic tools and commends for an illustrated work
& Adobe Hlustrator - Diagram
* Working process to create a spatial, sequential process diagram
oz
Depthmap - Data visualization
4
+ Concepts of Space Syntax and the examplas
« Ready for Space Syntax images
+ Generate isovist, connectivity, and gate count graphics
05 Finalize data visuslization exercise.
Wacom tablet & Painter — User interface
06
*  Various types of perspectives using hybrid techniques
« Wacom tablet technology
« “Painter Essentials” and similar applications in the industry
* The user interface of “Painter Essentials”
Painter - Tools and brushes
04 o7
« Four types of working in Painter
+  Basic tools and penels in Painter
* Brushes in painter - Choosing and acguiring brushes
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Painter - Auto painting & Clone painting
08
*  Various brushes and categories
+ Al puto-painting
« Clone painting
iPad and Procreate
os :
« Introduction to Procreate
« The user interface and gestures of “Procreate”
+  Various Brushes can color
05 =  Various tools in the app
*  Various working processes for perspective views
10 Finalize the hybrid digital drawing exercise.
Revit — Family parameter
11
+  Parometers in Revit family modeling
« Create a simple chair with parameters
« Create a simple tsble with parameters
(L]
Revit — Nested family
12
« Nested Revit family and how it works
« Create a chair and table set with nested Revit families
«  Modify a door family
Revit — Organic shaped walls
07 13
« Create a slanted wall without Massing tools
+ Understand various 3D models using Massing
« Create an organic shape wall
+ Create an organic shape curtaimwall
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Revit — Organic shaped ceiling and column

14
« Create an orgamic wooden pattern ceilingwalllbench
« Create a geometric pattern ceiling
« Create organic column vs. geometric pattern column
Revit — Sketchup models
15
+ Create an ndvanced Revit Site model (Surroundings|
« Import Sketchup models in Revit project with material changes
+ Import Sketchup models in Revit project without the complex lines using 30s Max
08
Sketchup advanced modeling
&
« The process of a Revit model to a Sketchup model for rendering
+ The Sketchup modeling process and strategies
* Skerchup sdvanced modeling with plug-ins
17 Finalize the advanced modeling exercise.
02 -
V-Ray for SketchUp
18 *  Beinrroduced o VREAY
«  Vray render and camers settings
*  Vroy material settings
«  Vray lighting settings
« The Final render and save the image
Lumion — User interface & import 3D model
10 19

Be introduced to Various Rendering software
Install Lumion Pro Student

Understand the interface

Impart a 30 model
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Lumion - surroundings, objects, & materials
20
« Add surrcundings
«  Add objects
«  Addledit matarinls
Lumion — Lightings, scenes, & outputs
21
«  Addiedit lighting
«  Addledit scenes
*  Render outputs
11
Photoshop — brushes and quick retouch
2
*  Be oware of various tips and skills for better interior perspective renderings
=  Be introduced to various sites for texture, cutowes, nnd more for references
« Beahle to produce a rendering with a quick retouch
Photoshop — Advanced rendering post-production
et
+ Understand post-production for exterior perspective rendering
= Understand post-production for interior perspective rendering
12
24 Finalize the advanced rendering exercise.
Enscape — walk-through video
13 25
+ Be aware of various tips and skills for better interior 30 animation
= Create o walk-through video in Enscpae
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Lumion — walk-through video

26

«  Create a walk-through video in Lumion
Premiere — Video production
27
14 + Adobe Premiere pro the User Interface

*  Add videos and titles
= Edit videos and add transitions
= Add/edit sounds

8 Finalize the 3D pnimption exercise.
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